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About This Course 

gtslearning's CompTIA A+ Support Skills courses are intended for students 
wishing to qualify with CompTIA A+ Certification. A+ certification is designed to 
help students become entry-level IT technicians. 

Successful candidates will have the knowledge required to assemble 

components based on customer requirements, install, configure and 

maintain devices, PCs and software for end users, understand the basics of 

networking and security/forensics, properly and safely diagnose, resolve and 

document common hardware and software issues while applying 

troubleshooting skills. Successful candidates will also provide appropriate 

customer support; understand the basics of virtualization, desktop imaging, 

and deployment. 

CompTIA A+ syllabus 

This course is designed to prepare you for the 220-802 A+ exam. It focuses on 
supporting Microsoft Windows, configuring SOHO networks with internet 
access, troubleshooting, and features of mobile devices such as smartphones. 

 To obtain CompTIA A+ Certification, you must pass both the 802 

exam and the 220-801 exam. You must complete the 801 Support 

Skills course to prepare for the 801 exam. The 801 exam focuses 

PC, laptop, printer, and network hardware technologies and 

support procedures. 

What are the Course Prerequisites? 

Ideally, you should have successfully completed gtslearning's "PC 
Fundamentals with CompTIA Strata" course or have some basic experience of 
using a PC, Windows, and browsing the web. It is also recommended that you 
complete the 801 Support Skills course before starting this course. Specifically, 
it is recommended that you have the following skills and knowledge before 
starting this course: 

■ Use Windows Explorer to create directories and subdirectories and move 
and copy files and directories and use Internet Explorer to view websites. 

■ Identify types and characteristics of PC and laptop components, including 
motherboard, CPU, memory, and storage, input, and output devices. 

■ Install and configure peripheral devices and system components. 

■ Install and configure print devices. 

■ Install and configure wired and wireless LAN links and internet access 
devices. 

Optionally, you can take a prerequisites test to check that you have the 
knowledge required to study this course at the gtslearning Freestyle site 
accompanying this study guide (see below for details on registering). 

http://gtsgo.to/4mywk
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Course Outcomes 

This practical "hands-on" course will teach you the fundamental principles of 
supporting Windows and troubleshooting computer systems and basic 
networks. As a PC technician, you will be expected to support old and new 
systems, so it is important that you have a full understanding of legacy 
hardware and software, as well as the latest technologies. On course 
completion, you will be able to:  

■ Install and configure Microsoft Windows XP / Vista / 7. 

■ Manage and optimize Windows using command line tools and 
administrative consoles. 

■ Configure and manage users, groups, and shared resources in a typical 
SOHO network. 

■ Use anti-virus tools to prevent and recover from malware infections. 

■ Configure access control measures, such as authentication, security policy, 
encryption, and firewalls. 

■ Diagnose and resolve Windows, PC hardware, network, and printer 
troubleshooting scenarios. 

■ Configure mobile devices, such as smartphones and tablets. 

How Certification Helps Your Career 

Certification proves you have the knowledge and skill to solve business 
problems in virtually any business environment. Certifications are highly valued 
credentials that qualify you for jobs, increased compensation, and promotion.  

 

CompTIA A+ certification is held by many IT staff in organizations. Worldwide, 
more than 800,000 individuals are CompTIA A+ certified and 31% of IT staff 
within a random sampling of US organizations within a cross section of 
industry verticals hold A+ Certification. Indeed, A+ Certification is often a 
prerequisite qualification for employment and is mandated or recommended by 
many leading computer manufacturers and vendors, such as Cisco and HP 
and Ricoh, the US State Department, and US government contractors such as 
EDS, General Dynamics, and Northrop Grumman. 

IT is 
Everywhere

IT  is 
ubiquitous; a 

critical 
requirement of 

most 
organizations. 
Globally, there 

are over 
600,000 IT job 

openings.

IT Knowledge 
and Skills Gets 

Jobs

Certifications 
are essential 
credentials 
that qualify 
you for jobs, 

increased 
compensatio

n, and 
promotion.

Retain your 
Job and Salary 

Make your 
expertise stand 
above the rest. 
Competence is 

usually retained 
during times of 

change.

Want to 
Change Jobs? 

Certifications 
qualify you for 

new 
opportunities, 
whether you 
see limited 

advancement 
in your current 
job or need to 

change careers. 

Stick Out from 
the Resume 

Pile

Hiring 
managers can 
demand the 

strongest skill 
set.
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CompTIA Career Pathway 

Completing this course will help you to pursue a career in computer and 
network support. This course will particularly benefit you in pursuing a career in 
supporting desktop personal computer users, in job roles such as Support 
Engineer, Maintenance Engineer, Desktop Engineer, Computer Administrator, 
or PC Support Analyst. CompTIA offers a number of credentials that form a 
foundation for your career in technology and allow you to pursue specific areas 
of concentration. Depending on the path you choose to take, CompTIA 
certifications help you build upon your skills and knowledge, supporting 
learning throughout your entire career. 

 
 

Study of the course can also help to prepare you for other, similar technical 
support qualifications and act as groundwork for more advanced training. 
Other qualifications available include: 

■ CompTIA Network+ - a foundation-level certification of competency in 
network installation and configuration. 

■ CompTIA Server+ - validates the skills of advanced IT technicians 
(individuals with 18-24 months' experience with Industry Standard Server 
Architecture [ISSA]). 

■ CompTIA Security+ - validates knowledge of communication security, 
infrastructure security, cryptography, operational security, and general 
security concepts. 

■ Cisco Certified Network Associate (CCNA) - a foundation-level certification 
of competency in Cisco networking appliance installation and configuration. 

■ Microsoft Certified Solutions Expert (MCSE) - Windows-specific 
qualifications covering support and design of client and server 
infrastructure, as well as other Microsoft technologies. 

http://gtsgo.to/nvpm7
http://gtsgo.to/76m16
http://gtsgo.to/vbty3
http://gtsgo.to/431tb
http://gtsgo.to/vgz2g
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About the Course Material 

The course material has been prepared as an aid for your use throughout the 
training course. We hope you will also find the course material useful for future 
reference. 

The course comes in two parts. This "Study Notes" volume contains the main 
text of the book for you to refer to in class and to review at home as you 
prepare for the exam. The course text is divided into several modules, each 
covering a different subject area. Each module is split into a series of units 
containing related topics for study. Each unit has a set of review questions 
designed to test your knowledge of the topics covered in the unit. At the back 
of the "Study Notes" volume there is an index to help you look up key terms 
and concepts from the course. 

The accompanying "Labs and References" volume contains a list of the 
CompTIA certification objectives (and where in the study notes you can find 
useful material to prepare for each objective), tips for taking the CompTIA 
exams, the practical labs for you to complete in class, answers to the end of 
unit review questions, and a glossary of terms and concepts used in computer 
support.  

 If you are viewing this course as an ebook, the "Labs and 

References" volume is located after the index - use the bookmarks 

panel to navigate between sections. 

Integrated Video Training from Professor Messer 

Professor Messer has long been a web hero for CompTIA certification 
students. With professionally-produced lessons covering the full exam 
objectives and online forums, Professor Messer is a trusted online source for 
exam information. Professor Messer uses gtslearning's CompTIA certification 
courseware to develop and record his popular video training sessions. Now 
you can easily follow along with his video presentations using the links 
provided in this course book. You can use the links in three ways: 

1) If you have an ebook, just click the link to open the video 
in your browser. 

2) If you have a QR code scanner, point your camera at the 
code to open it in your phone or tablet's browser.  

3) If you have a printed book but no scanner, enter gtsgo.to/ followed by 
the code printed under the QR graphic into your browser. For example, to   
access the code shown above and open gtslearning's home page, enter 
gtsgo.to/pk28w. 

 We do endeavor to keep the video links up-to-date, but if you come 

across a broken link, please email the link code (for example 

"pk28w") to support@gtslearning.com and we will update it. 

http://gtsgo.to/dlbrs
mailto:support@gtslearning.com
http://gtsgo.to/pk8w
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Course Conventions and Icons 

The following conventions have been used in this course. These are especially 
useful for following the practical lab exercises. 

■ Bullet and number lists - steps for you to follow in the course of completing 
a task or hands-on exercise and review questions are indicated by 
numbered bullet points. Other bullet points indicate learning objectives and 
feature lists. 

■ File and command selection - in the labs, files, applets, dialogs and other 
information that is displayed on the screen by the computer is shown in 
sans serif bold. For example: Click OK, Select Control Panel, and so on. 

■ Sequences of commands - in the labs, a sequence of steps to follow to 
open a file or activate a command are shown in bold with arrows. For 
example, if you need to access the system properties in Windows, this 
would be shown in the text by: Start > Control Panel > System. 

■ Commands - commands or information that you must enter using the 
keyboard are shown in Courier New Bold. For example: Type 
webadmin@somewhere.com. Courier New Bold-Italic represents some 
sort of variable, such as your student number. For example, if your student 
number is "5", you would follow the instruction ping 10.0.0.x by 
entering ping 10.0.0.5. 

■ Using the mouse - when instructed to click, use the main mouse button; 
when instructed to alt-click, use the secondary button (that is, the button on 
the right-hand side of the mouse, assuming right-handed use). Sometimes 
you need to use both the keyboard and the mouse - for example, 
Ctrl+click means hold down the Ctrl key and click the main mouse 
button. 

The following symbols are used to indicate different features in the course 
book: 

Icon Meaning 

 

A tip or warning about a feature or topic. 

 

A reference to another unit, where more information 
on a topic can be found. 

 

A link to a Professor Messer video presentation. 
Click or use a QR scanner to open the link or enter 
gtsgo.to/ followed by the code printed under the 
QR graphic into your browser. 

 

Review questions to help test what you have 
learned. 

 

A hands-on exercise for you to practice skills 
learned during the lesson. 

Your instructor edition 
is identical to the 
student edition, except 
that there are notes to 
help you deliver the 
course in the margins 
and the answers to the 
review questions are 
always shown. 

 
 

This icon denotes a 
slide to accompany the 
text. 
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Freestyle Support Site 

gtslearning's Freestyle support site hosts study resources such as a 
prerequisites test and practice exam. 

 
Get tests and practice exams to accompany the course at gtslearning's Freestyle site 

1) Ask your training provider for the course enrollment key: 
________________________ 

2) Visit the Freestyle site (gtsgo.to/oup4x) and click the Create new account 
button. 

 
Creating an account 

3) Complete the sign-up process. You will need to validate the account using 
your email address. 

4) When you have validated your account, open gtsgo.to/8jl00 and log in if 
necessary. 

5) Enter your enrollment key to get access to the course resources. 

http://gtsgo.to/oup4x
http://gtsgo.to/8jl00
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Content Seal of Quality 

This courseware bears the seal of CompTIA Official Approved Quality 

Content. This seal signifies this content covers 100% of the exam objectives 
and implements important instructional design principles. CompTIA 
recommends multiple learning tools to help increase coverage of the learning 
objectives. The contents of this training material were created for the CompTIA 
A+ Certification 220-802 exam covering the 2012 Edition exam objectives 
and content examples. 

  

 It is CompTIA's policy to update the exam regularly with new test 

items to deter fraud and for compliance with ISO standards. The 

exam objectives may therefore describe the current "Edition" of the 

exam with a date different to that above. Please note that this 

training material remains valid for the stated exam code, regardless 

of the exam edition. For more information, please check the FAQs 

on CompTIA's website (support.comptia.org). 

Four Steps to Getting Certified 

This training material can help you prepare for and pass a related CompTIA 
certification exam or exams. In order to achieve CompTIA certification, you 
must register for and pass a CompTIA certification exam or exams. In order to 
become CompTIA certified, you must: 

1) Review the certification objectives at 
www.comptia.org/certifications/testprep/examobjectives.aspx to make sure 
you know what is covered in the exam.  

2) After you have studied for the certification, take a free assessment and 
sample test from CompTIA at 
www.comptia.org/certifications/testprep/practicetests.aspx to get an idea 
what type of questions might be on the exam. You can also use 
gtslearning's free practice tests on Freestyle (gtsgo.to/9nz8x). 

3) Purchase an exam voucher on the CompTIA Marketplace, which is located 
at www.comptiastore.com. 

4) Select a certification exam provider and schedule a time to take your exam. 
You can find exam providers at 
www.comptia.org/certifications/testprep/testingcenters.aspx 

Visit CompTIA online - www.comptia.org to learn more about getting CompTIA 
certified. Contact CompTIA - call 866-835-8020 ext. 5 or email 
questions@comptia.org.  

http://support.comptia.org/
http://www.comptia.org/certifications/testprep/examobjectives.aspx
http://www.comptia.org/certifications/testprep/practicetests.aspx
http://gtsgo.to/9nz8x
http://www.comptiastore.com/
http://www.comptia.org/certifications/testprep/testingcenters.aspx
http://www.comptia.org/
mailto:questions@comptia.org
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Module 1 / Supporting Windows 1 

A+ Certification 220-802 Domain Areas % of Exam 

1.0 Operating Systems 33%  
2.0 Security 22%  
3.0 Mobile Devices 9%  
4.0 Troubleshooting 36%  

 
 

Unit Domain Objectives / Examples 

1.1 Windows 
Operating 

System 

1.1 Compare and contrast the features and 
requirements of various Microsoft Operating 
Systems. 
Windows XP Home, Windows XP Professional, 
Windows XP Media Center, Windows XP 64-bit 
Professional • Windows Vista Home Basic, Windows 
Vista Home Premium, Windows Vista Business, 
Windows Vista Ultimate, Windows Vista Enterprise • 
Windows 7 Starter, Windows 7 Home Premium, 
Windows 7 Professional, Windows 7 Ultimate, Windows 
7 Enterprise • Features (32-bit vs. 64-bit, Aero) • 
Upgrade paths (Differences between in-place upgrades, 
Compatibility tools, Windows Upgrade OS Advisor) 

1.2 
Administration 

Tools 

1.1 Compare and contrast the features and 
requirements of various Microsoft Operating 
Systems. 
Features (Administrative Tools, File structure and paths, 
Category view vs. classic view) 

1.3 Given a scenario, use appropriate command line 
tools. 
OS (shutdown, [command name] /?) 

1.4 Given a scenario, use appropriate operating 
system features and tools. 
Administrative (Computer Management) • Run line 
utilities (regedit, cmd, mmc, notepad) 

1.8 Explain the differences among basic OS security 
settings. 
System files and folders 

1.3 Managing 
Users 

1.1 Compare and contrast the features and 
requirements of various Microsoft Operating 
Systems. 
Features (User Account Control) 

1.4 Given a scenario, use appropriate operating 
system features and tools. 
Administrative (Users and Groups) 

1.5 Given a scenario, use Control Panel utilities. 
User Accounts 

1.8 Explain the differences among basic OS security 
settings. 
User and groups (Administrator, Power User, Guest, 
Standard User) 

Delivery Tips 

The exams no longer 
have official names but 
801 collects most of 
the hardware topics 
together while 802 is 
more focused on the 
OS, but does include 
hardware 
troubleshooting. 

Consequently, 
students must have 
completed the 801 
course to follow this 
one. If running the 
courses together, you 
may prefer to run 
modules 1-3 of 802 
then 801, and finish 
with modules 4-5 of 
802. 

Each module in the 
course is designed to 
correlate to one 
training day, though 
you may wish to adjust 
timings depending on 
the students' level of 
existing knowledge 
and experience. 

The first two modules 
cover the Windows 
administration 
features. The third 
module looks at 
Windows 
troubleshooting and 
security issues. 

The final modules 
cover hardware 
troubleshooting and 
then TCP/IP and 
Windows network 
configuration and 
troubleshooting.  

Note that the exam 
now includes 
performance-based 
items in a simulated 
Windows environment 
so the lab work will be 
very important to the 
students' chances of 
success. 
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Unit Domain Objectives / Examples 

1.4 Managing 
Storage 

1.2 Given a scenario, install, and configure the 
operating system using the most appropriate 
method. 
Partitioning (Dynamic, Basic, Primary, Extended, 
Logical) • File system types/formatting (FAT, FAT32, 
NTFS, CDFS, Quick format vs. full format) 

1.3 Given a scenario, use appropriate command line 
tools. 
OS (fdisk, format, diskpart, chkdsk) 

1.4 Given a scenario, use appropriate operating 
system features and tools. 
Disk Management (Drive status, Mounting, Extending 
partitions, Splitting partitions, Assigning drive letters, 
Adding drives, Adding arrays) 

4.3 Given a scenario, troubleshoot hard drives and 
RAID arrays with appropriate tools. 
Tools (format, fdisk) 

1.5 Managing Files 1.3 Given a scenario, use appropriate command line 
tools. 
OS (md, rd, cd, del, copy, xcopy, robocopy) 

1.4 Given a scenario, use appropriate operating 
system features and tools. 
Run line utilities (Explorer) 

1.5 Given a scenario, use Control Panel utilities. 
Folder Options (View hidden files, Hide extensions, 
Layout) 
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Module 1 / Unit 1 
Windows Operating System 

Objectives 

On completion of this unit, you will be able to: 

■ Describe the main features and system requirements of Windows XP, 
Windows Vista, and Windows 7. 

■ Distinguish between different editions of Windows XP, Windows Vista, and 
Windows 7. 

■ Configure elements of the GUI (desktop, Start menu, and taskbar). 

What is an Operating System? 

A PC requires an Operating System (OS) in order to function. The operating 
system provides the interface between the hardware, application programs, 
and the user. The operating system handles many of the basic system 
functions, such as interaction with the system hardware and input / output. 

An operating system is generally made up of a number of core files (the 
kernel) with additional device drivers and programs to provide extended 
functionality. The earliest operating systems for PCs (Microsoft's Disk 
Operating System [DOS]) used a command-line interface or simple menu 
systems. Windows and later applications were marked by the use of a 
Graphical User Interface (GUI)1. This helped to make computers easier to 
use by non-technical staff and home users. 

The market for operating systems is divided into three main functions: 

■ Business client - OS designed to work as a client in business networks. 

■ Network Operating System (NOS) - OS designed to run on servers in 
business networks. 

■ Home client - OS designed to work on standalone or workgroup PC in a 
home or small office. 

Windows is the dominant client OS, estimated to be installed on 90% of the 
world's desktop and laptop computers. Other desktop operating systems 
include Apple Mac OS and the various types (often referred to as distributions 
or "distros") of Linux, an open-source OS. 

                                                      
1 Actually, some DOS applications presented a GUI (of a kind). Windows is sometimes described 
as a WIMP (Window, Icon, Menu, Pointing device) interface. 

 
 

Delivery Tips 

This unit gives a broad 
overview of the 
Windows platform. 

Timings 

Theory & Review 
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minutes 
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Windows 7 

 
Microsoft released Windows 7, the successor to Windows Vista and Windows 
XP, in 2009. While Windows Vista was relatively unsuccessful, Windows 7 is 
the most popular operating system in use on desktop PCs and laptops2. 

Desktop, Taskbar, and Start Menu 

One of the main functions of an OS is to provide an interface between the user 
and the computer hardware and software. Windows has a number of interface 
components designed both for general use and for more technical 
configuration and troubleshooting. Collectively, the user interface is referred to 
as the shell. 

 Make sure you know how to navigate Windows and know the 

routes to open the various administration and file management 

tools. 

The top level of the user interface is the Desktop. This is displayed when 
Windows starts and the user logs on. 

 
Windows 7 desktop showing 1) Shortcut icon; 2) Start orb; 3) "Pinned" program (Internet Explorer) 

with open windows; 4) Pinned programs with no open windows; 5) Notification Area 

The Desktop contains icons to launch applications and possibly user data files. 

                                                      
2 The Windows XP install base is almost as large though obviously declining as Microsoft reduce 
support options available for it. 

  
 

Windows 7 is proving 
to be more of a natural 
upgrade from 
Windows XP than 
Vista. 

http://gtsgo.to/3k7gr
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The Desktop also contains the Start menu and taskbar, which are used to 
launch and control applications. 

The Start menu lists all the programs installed on the computer within 
Program Groups, represented as submenus. There are also items for 
accessing recently-used programs and documents, searching for files and 
folders, accessing the help system, and shutting down the PC. 

 
Start menu and taskbar showing 1) Click All Programs to view all application shortcuts or use the 
Instant Search box below; 2) Items can be pinned to the Start Menu and recently used shortcuts 
appear below; 3) Shortcuts to system folders and settings; 4) This button offers different ways to 
close a session (shut down, hibernate, and so on); 5) Pinned Taskbar icons; 6) Other icons show 

open windows; 7) Notification Area containing background process icons and the clock 

Apart from containing the Start button, the Taskbar's main function is to show 
the programs (windows) currently running on the desktop. On the left are 
"pinned" icons for frequently used programs such as email and web browser. 
Pinned items always remain on the Taskbar (a program with open windows is 
shown with a highlight). You can add or remove or reposition pinned items by 
dragging and dropping. 

At the end of the Taskbar is the Show Desktop toggle icon. Pointing at 
this icon makes all windows transparent ("Aero Peek") while clicking it 
minimizes or restores all open windows. 

 

Taskbar icons also enable peeking at the window contents by pointing to them 
and have a close button for the window. The shortcut menu for each icon 
displays a "Jump List" of recently used files or common tasks. 

Desktop windows also support some gesture controls. If you "shake" a window 
by its title bar all other windows are minimized; Windows will also snap 
automatically into a suitable position when dragged to a part of the desktop or 
alongside one another. 



Evaluation Use Only

  

 

Module 1 / Unit 1 

Page 6 

© 2013 gtslearning 

The area on the right-hand side of the taskbar is called the Notification Area 
(or sometimes by its old name of systray or system tray). This displays the 
current time and icons for programs that run without a window, such as anti-
virus software, volume control, battery meter, network status, and so on. These 
icons have shortcut menus for enabling, disabling, and configuring the related 
application or setting. 

The Start menu and taskbar can be customized by alt-clicking and selecting 
Properties. This allows you to show or hide various options and add or 
remove program shortcuts. You can also use drag-and-drop to add or remove 
shortcuts from the menu. 

  
Configuring Start menu properties 

 
Configuring Taskbar properties 
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The taskbar can be dragged to different sides of the screen and resized using 
the mouse. There is also an Auto-Hide property, which means the taskbar only 
pops into view if the mouse is moved where it should be. 

 Make sure that you can operate a PC without using the mouse. 

Check websites for extra tips and shortcuts. The Microsoft 

Knowledge Base (support.microsoft.com/search) has an exhaustive 

list of keyboard shortcuts. 

Aero 
 
The Windows desktop is controlled by the Desktop Window Manager 

(DWM.EXE) process. Compared to older versions of Windows (Windows XP 
and earlier), Aero specifies a number of improvements to the way the desktop 
works and looks (themes). It includes things such as design guides for wizards 
and notifications, but the following features are most obvious to users: 

■ Scalable icons and previews of window / file contents. 

■ Aero Glass theme - translucent title bars and window borders. 

■ Flip3D window manager, displaying 3D previews of open windows 
(activated by pressing Start+Tab). 

 
Windows Aero theme and Flip3D window selection 

These effects require a fairly substantial graphics adapter but Windows selects 
appropriate settings on installation and individual effects can be customized 
and enabled or disabled by the user. 

Gadgets 

The Desktop can also host mini-applications, referred to as gadgets. Default 
gadgets include things such as a clock, calendar, RSS news ticker, weather 
report, and so on. You can configure gadgets by alt-clicking or via the Desktop 

Gadgets applet in Control Panel. 

http://support.microsoft.com/search/
http://gtsgo.to/a6nx6
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Windows 7 Editions 

Editions are used by Microsoft to create different markets for Windows. Some 
editions of Windows are cheaper and have fewer features than others; some 
are designed for home use and others for use in businesses3. 

Windows 7 Starter Edition 

This edition in only available pre-installed on netbooks and sub-notebooks. 
Unlike previous Starter editions, it is no longer limited to running three end-
user applications concurrently. It still comes with a very limited range of 
features. The basic desktop theme cannot be customized for instance and 
there is no DVD playback (without third-party software). Also, the Starter 
edition can join a homegroup (a means of sharing files in Windows 7) but 
cannot be used to configure one. 

Windows 7 Home Editions 

The Windows 7 Home Editions are aimed (obviously) at home or small office 
users, where computers are configured in a workgroup network. There is no 
support for joining Active Directory networks run by Microsoft Windows Server. 
There are Home Basic and Home Premium versions. The Home Basic edition 
is not available to retail customers in "first world" countries. Home Basic cannot 
be activated outside of a defined list of regions. 

Home Premium comes with the full range of Aero features, supports touch 
screen and tablet (ink) input, and comes with some extra tools (notably Media 
Center, High Definition video editing, and DVD playback and authoring). 

Windows 7 Business Editions 

Windows business networks are based around the use of Windows Server, 
which runs a network service called Active Directory. Business editions of 
Windows include client software that can join an Active Directory (or domain) 
network. The business editions also include file encryption, offline folders, and 
a server to allow the computer to be controlled remotely (Remote Desktop).  

The business editions come with a feature called XP mode. XP mode allows 
the user to run a copy of Windows XP "within" the Windows 7 installation as a 
virtual machine, providing compatibility for older software and hardware. 

There are two business editions: Professional and Enterprise. The Enterprise 
edition is only available to volume license customers (that is, it is not available 
for retail purchase). Compared to the retail Professional edition, it adds drive 
encryption (BitLocker), a language pack to enable the use of different 
languages for the Windows interface elements, and support for UNIX 
applications. 

                                                      
3 "N" editions released in the European Union do not feature tools such as Media Player or Movie 
Maker as part of Microsoft's settlement with the EU over monopolistic trade practice. 

  
 

There are significant 
differences between 
the versions or 
"Editions". 
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Windows 7 Ultimate 

The Windows 7 Ultimate edition is essentially a retail version of Windows 7 
Enterprise. The only significant additional features compared to the Home 
Premium and Business editions are the BitLocker drive encryption product and 
support for multiple interface languages. The only real reason for its existence 
is to provide an in-place upgrade path for Windows Vista Ultimate users. 

64-bit Editions of Windows 7 

Each edition of Windows 7 (except Starter) is available as 32-bit or 64-bit (x64) 
software. 64-bit editions of Windows 7 also require 64-bit hardware device 
drivers authorized by Microsoft ("signed"). If the vendor has not produced a 64-
bit driver, the hardware device will not be usable. 

Windows 7 System Requirements 

Before installing or deploying an OS, it is necessary to ensure that the 
computer(s) meets the minimum hardware specification. The minimum 
requirements quoted in the table below will allow you to install and run 
Windows, but you should not expect outstanding performance at the minimum 
specification. System requirements will be considerably higher for many 
software applications. 

Component Minimum Specification 

CPU 1 GHz. 
Memory 1 GB RAM. 
Display Support for DirectX9 graphics (or later) and 

Windows Display Driver Model (WDDM) 1.0 for Aero 
support. 

Hard disk 16 GB free space. 
Installation Media DVD-ROM or cross-network. 
Audio Sound card and speakers are recommended. 

 
Unlike previous versions of Windows, Microsoft have not published official 
recommended specs but a dual-core CPU and 2 GB system RAM should 
provide acceptable performance for a machine running Office-type software. 

The following additional requirements apply to specific features: 

■ 64-bit - CPU supporting AMD64 or EM64T, 2 GB RAM, and 20 GB free 
hard disk space. 

■ Tablet / touch screen - runs only on dedicated hardware. 

■ Media Center - a TV Tuner card and an IR receiver for the remote control 
are recommended. 

In addition to the system requirements, you must ensure your system and all 
attached devices are in the Windows Logo'd Products catalog 
(sysdev.microsoft.com/en-US/Hardware/LPL/default.aspx). 

  
 

 

https://sysdev.microsoft.com/en-US/Hardware/LPL/default.aspx
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Windows 7 System Limits 

The various editions of Windows 7 have different restrictions in terms of CPU 
types and features and memory supported: 

Feature Home 

Basic 

Home 

Premium 

Professional Enterprise Ultimate 

64-bit Edition Yes Yes Yes Yes Yes 
SMP (Multiple 
CPUs) 

No No 2-way 2-way 2-way 

Multi-core Yes Yes Yes Yes Yes 
Memory (32-
bit) 

4 GB 4 GB 4 GB 4 GB 4 GB 

Memory (64-
bit) 

8 GB 16 GB 192 GB 192 GB 192 GB 

 
All editions support HyperThreading, hardware-assisted virtualization, and 
Data Execution Prevention. DVD playback and recording is supported4 but Blu-
ray requires third-party software. 

The Starter edition is only available to system builders (OEMs) and Microsoft is 
currently only licensing it for installation on netbooks and sub-notebooks. 
There is no 64-bit version of the Starter edition. 

Windows Vista 

 
Microsoft released Windows Vista in 2007 as the successor to Windows XP. 
Vista introduced the Aero graphics system (better suited to scaling to different 
resolutions and capable of displaying windows in 3D) and came with updated 
media tools, a reworked desktop search engine, and a greater selection of 
mini-applications for home use. 

Vista also refocused on security, with greater control over use of the local 
administrator account (User Account Control) and use of privilege restrictions 
to try to defeat malware. 

Windows Vista Editions 

Like Windows 7, there are numerous editions of Vista (including Home/Home 
Premium, Business/Enterprise, and Ultimate).  

Windows Vista Home Editions 

The Vista Home Editions are aimed at workgroup users. There is no support 
for joining Active Directory networks. 

                                                      
4 All editions can use DVD as a data disc; all editions except Home Basic include a DVD Maker 
tool for creating video or picture DVDs with navigation menus. 

 
 

While it was bundled 
with a lot of new home 
PCs, Windows Vista 
was never popular in 
the marketplace. 

http://gtsgo.to/e6ncu
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There are Home Basic and Home Premium versions. Home Premium supports 
more network client connections (10 compared to 5) and touchscreen and 
tablet (ink) input, and comes with some extra tools (notably Media Center, 
Meeting Space (a conferencing application for local networks), High Definition 
video editing, and DVD authoring). Also, the Home Basic edition does not 
include the Aero interface. 

Windows Vista Professional Editions 

The Active Directory client editions of Vista are Business and Enterprise. 
These include fax / scan tools, file encryption, and a Remote Desktop server. 

The Enterprise edition is only available to Software Assurance licensing 
customers. Compared to the retail Business edition, it adds drive encryption 
(BitLocker) and support for UNIX applications. 

Windows Vista Ultimate 

The "professional" editions of Vista do not include the multimedia tools 
supplied with the "home" editions, such as Media Center, DVD Maker, Movie 
Maker, and games. The Ultimate edition comes with all the features of Vista 
Home Premium and Vista Enterprise. 

Windows Vista Desktop 

The Vista desktop is broadly similar to Windows 7. In place of pinned Taskbar 
icons, there is a Quick Launch toolbar that can be configured with shortcuts to 
commonly-used programs. 

 
Vista desktop showing 1) Start orb; 2) Switch Between Windows button; 3) Welcome Center; 4) 

Sidebar with clock, slide show, and RSS news feed gadgets 
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 Aero Glass and Flip3D features are not available in the Home 

Basic edition. 

Sidebar 
 
The Sidebar is a strip that can be 
positioned on the right (default) or left 
of the desktop to host gadgets. You 
can configure the Sidebar by alt-
clicking it or by selecting its taskbar 
icon. 

 
Configuring the Sidebar 

Windows Vista System Requirements 

For good workstation throughput, you should be considering a dual-core 
processor and 1 GB RAM or more.  

Component Minimum and Recommended Specification 

CPU 800 MHz (1 GHz 32-bit or 64-bit recommended). 
Memory 512 MB RAM (1 GB recommended for all editions 

other than Home Basic). 
Display SVGA or higher (800 x 600). Support for DirectX9 

graphics and 32 MB graphics memory recommended. 
Aero requires 128 MB graphics memory, pixel shader 
2.0, and 32-bits / pixel. 

Hard disk 20 GB with 15 GB free space (40 GB recommended 
for all editions other than Home Basic). 

Installation Media DVD-ROM or cross-network. 
Audio Sound card and speakers are recommended. 

 
As well as determining the system requirements to support Windows Vista, 
ensure that any third-party hardware devices you have will also support it. At 
launch, third-party support for Vista was quite patchy. While the situation 
improved as regards newly released devices, older hardware may not have 
suitable drivers. 

The following additional requirements apply to specific features: 

■ x64 - CPU supporting AMD64 or EM64T. 

■ Tablet / touchscreen - runs only on dedicated hardware. 

■ Media Center - a TV Tuner card and an IR receiver for the remote control 
are recommended.  

It's always worth 
memorizing the 
hardware 
requirements. 

http://gtsgo.to/lg7zq
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Windows Vista System Limits 

The various editions of Windows Vista have different restrictions in terms of 
CPU types and features and memory supported: 

Feature Home 

Basic 

Home 

Premium 

Business Enterprise Ultimate 

64-bit Edition Yes Yes Yes Yes Yes 
SMP No No 2-way 2-way 2-way 
Multi-core Yes Yes Yes Yes Yes 
Memory (32-bit) 4 GB 4 GB 4 GB 4 GB 4 GB 
Memory (64-bit) 8 GB 16 GB 128 GB 128 GB 128 GB 

 
All editions support HyperThreading, hardware-assisted virtualization, and 
Data Execution Prevention. DVD playback and recording is supported5 but Blu-
ray requires third-party software. 

Windows XP 

 
Windows XP, released in 2002, is the earliest Windows version you are 
expected to support. While 10 years old at the time of writing, it is still almost 
as widely deployed as Windows 7. 

 
Windows XP desktop 

                                                      
5 All editions can use DVD as a data disc; the Home Premium and Ultimate editions include a DVD 
Maker tool for creating video or picture DVDs with navigation menus. 

 
 

Windows XP is the 
most important OS in 
terms of install base 
and support. It 
accounts for just under 
50% of usage on the 
web. 

 

http://gtsgo.to/zwx1s
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Windows XP Editions 

Like its successors, there are also various editions of Windows XP. 

Windows XP Professional 

The "standard" version of Windows XP for business clients is Windows XP 

Professional. This is the preferred client for Windows Domain (Active 
Directory) networks.  

Microsoft released several editions alongside the Professional edition, 
designed for different markets. 

Windows XP Home Edition 

Windows XP Home Edition is a cheaper, stripped down version of Windows 
XP Professional. It does not support an Active Directory Client, Remote 
Desktop server, or Encrypting File System, and has a simplified user access 
control model. It supports up to 5 client connections in a workgroup rather than 
Professional's 10. 

Windows XP Media Center Edition (MCE) 

Only available to OEMs (Original Equipment Manufacturer), this version makes 
the computer a "digital media hub" capable of TV reception and recording. 
MCE is based on Windows XP Professional, but features an extra shell that 
can be operated using a TV-style remote control. The use of a suitable tuner 
card allows TV and radio reception and playback, as well as DVD/CD playback 
and storage of audio and video data. There have been several versions of 
MCE (one each year from 2002 to 2005 in fact). The last version cannot be 
used as an Active Directory client, but does feature a tweaked desktop color 
theme and supports the other features of the Professional edition. 

 
Windows XP MCE 2005 
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Windows XP Tablet PC Edition 

Windows XP Tablet PC Edition is a version optimized for Tablet PCs. It 
provides support for handwriting recognition and the touchscreen interface 
through its "Ink" features. Otherwise it is identical to Windows XP Professional 
Edition. 

Windows XP x64 Edition 

A version of the Professional edition optimized for x64 platforms. 

Windows XP with Advanced Security Technologies (SP2) 

In 2004, Windows XP SP2 was released. This service pack6 introduced a new 
Security Center applet for the Control Panel, an improved Windows Firewall 
(now activated by default), and improvements to Internet Explorer, including a 
pop-up window blocker and an Information Bar to warn about harmful 
content. 

Windows XP System Requirements 

The following requirements are for Windows XP Professional and Home 
editions.  

Component Minimum and Recommended Specification 

CPU 32-bit x86 (233 MHz or higher). 300 MHz (or 
better) recommended. 

Memory 64 MB RAM (128 MB recommended). 
Display SVGA or higher (800 x 600). 
Hard disk 1.5 GB free disk space + paging space. It is 

therefore recommended that you have at least 2 
GB of free space available.  

Installation Media CD-ROM or cross-network. 
 

The following additional requirements apply to the various editions of XP: 

■ x64 - CPU supporting AMD64 or EM64T and 256 MB system memory. 

■ Tablet - runs only on dedicated hardware. 

■ MCE - this requires considerably more computing power (a 1.6 GHz CPU 
and 256 MB memory at least) and disk space for good usability. To receive 
TV broadcasts, it also needs a TV Tuner card and an IR receiver for the 
remote control.  

                                                      
6 A service pack collects patches and fixes that have been released so far and may add new 
features. 

 
 

It's always worth 
memorizing the 
hardware 
requirements. 

Stress the point that 
64-bt versions of 
Windows support more 
than 4 GB system 
memory. 
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Windows XP System Limits 

The various editions of Windows XP have different restrictions in terms of CPU 
types and features and memory supported: 

Feature Home Professional MCE Tablet 

Edition 

64-bit (x64) Edition No Yes  No No 
SMP No 2-way No 2-way 
Multi-core Yes Yes Yes Yes 
HyperThreading Yes Yes Yes Yes 
Virtualization (VT-x / 
AMD-V) 

Yes 
(SP2) 

Yes (SP2) Yes 
(SP2) 

Yes (SP2) 

Data Execution 
Prevention 

Yes 
(SP2) 

Yes (SP2) Yes 
(SP2) 

Yes (SP2) 

Physical Memory (32-
bit) 

4 GB 4 GB 4 GB 4 GB 

Physical Memory (64-
bit) 

N/A 128 GB N/A N/A 

 
Third-party software may be required to support DVD / Blu-ray playback and 
recording7. 

Windows Upgrade Paths 

 
Replacing an earlier version of Windows with a newer one is an upgrade. 
Broadly speaking, an upgrade can take place in two ways: 

■ In-place - the existing OS is upgraded. This preserves the existing 
applications, data files, and user settings. 

■ Clean install - an ordinary installation is performed over the existing OS 
(which would normally be deleted first). If data or settings from the old 
system need to be preserved, these would need to be backed up and 
migrated to the new environment. Applications would also need to be re-
installed. 

Generally speaking, in an enterprise environment in-place upgrading of client 
machines is probably pretty inefficient; most network administrators tend to 
favor performing clean installations. 

On smaller networks or for home use, in-place upgrades are simpler. An in-
place upgrade must follow a supported upgrade path however. 

 Installation steps and procedures are covered in detail in Unit 2.4. 

                                                      
7 In 2007, Microsoft released a patch to support DVD recording under XP SP2 and SP3. 

 
 

We'll get to actual 
installation procedures 
later but students need 
to know the upgrade 
paths. 

http://gtsgo.to/lqg15
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Upgrading to Windows XP 

The table below summarizes the in-place upgrade paths to specific editions of 
Windows XP from various older Windows products.  

Product Upgrade Path 

Windows 95 Upgrade to Windows 98 then 
Windows XP Professional or Home 
Edition 
Upgrade to Windows 2000 then 
Windows XP Professional 

Windows 98 / Windows 98 Second 
Edition 

Windows XP Professional / Windows 
XP Home 

Windows Me Windows XP Professional / Windows 
XP Home 

Windows NT4 Workstation (SP5) Windows XP Professional 
Windows 2000 Professional Windows XP Professional 
Windows NT Workstation 3.51 Upgrade to Windows NT 4.0 (SP5) 

then Windows XP Professional 
Windows XP Home Edition Windows XP Professional 

 You cannot "downgrade" from Windows XP Professional to Home 

Edition. You cannot upgrade any product to Windows XP Media 

Center Edition. 

 
Upgrading from Windows 2000 to Windows XP 

Students should 
memorize these 
upgrade paths. 
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Upgrading to Windows Vista 

Windows Vista only supports in-place upgrades from Windows XP 32-bit 
versions and other editions of Vista8. The table below summarizes the in-place 
upgrade paths for the various editions.  

Product Upgrade Path 

Windows XP Professional Windows Vista Business or Ultimate 
Windows XP Home Edition Windows Vista Home Basic, Home 

Premium, Business, or Ultimate 
Windows XP Media Center Edition 
(MCE) 

Windows Vista Home Premium or 
Ultimate 

Windows XP Tablet PC Windows Vista Business or Ultimate 
Windows Vista Starter Windows Vista Home Basic, Home 

Premium, Business, or Ultimate 
Windows Vista Home Basic Windows Vista Home Premium, 

Business, or Ultimate 
Windows Vista Home Premium Windows Vista Ultimate 
Windows Vista Business Windows Vista Ultimate 
Windows Vista Enterprise Windows Vista Ultimate 

 

 You cannot upgrade from a 32-bit version of Windows to a 64-bit 

version nor can you upgrade from Windows XP x64 Edition to any 

64-bit edition of Vista. 

Upgrading to Windows 7 

Windows 7 only supports in-place upgrades from Windows Vista and other 
editions of 7. As with Vista, you can only perform an in-place upgrade to an 
equivalent or higher edition. For example, you cannot perform an in-place 
upgrade of Windows Vista Ultimate to Windows 7 Home Premium. 

You can run a graphical tool to check the compatibility of software and 
hardware on the target machine against Microsoft's database. 

Click the Check Compatibility Online link from the setup disc to open the 
Upgrade Advisor site (windows.microsoft.com/en-
us/windows/downloads/upgrade-advisor). Download and install the Upgrade 
Advisor then run it to scan the computer. Make sure any peripheral devices 
such as printers or webcams that you want to use under Windows 7 are 
already connected. 

                                                      
8 If you have purchased Windows Vista upgrade media, any previous version of Windows 2000 or 
XP is valid for licensing purposes but will require a clean install if an in-place upgrade option is not 
available. 

 
 

 

 
 

 

http://windows.microsoft.com/en-us/windows/downloads/upgrade-advisor
http://windows.microsoft.com/en-us/windows/downloads/upgrade-advisor


Evaluation Use Only

  

 

Windows Operating System 

Page 19 

© 2013 gtslearning 

 
Windows 7 Upgrade Advisor report 

The Upgrade Advisor then reports on any compatibility issues or upgrade 
paths required for installation of 32-bit or 64-bit Windows. 
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Review Questions / Module 1 / Unit 1 / Windows Operating System 

Answer the following questions. The correct answers are in the accompanying 
"Labs and References" manual. 

1) If you plan to upgrade a computer to Windows XP, what should you check? 
That the computer's components are on the Hardware Compatibility 

List (HCL) or Windows Logo'd Products List, that the PC meets the 

minimum requirements, and that the current OS is a supported 

upgrade path. 

2) How much free disk space is required to install Windows XP Home edition? 
1.5 GB. 

3) Which version of Windows does NOT support gadgets? 
Windows XP. 

4) Which version(s) of Windows support Aero Peek? 
Windows 7. 

5) You are advising a customer on purchasing an upgrade of Windows XP to 
Windows 7. The customer has expressed admiration for the "Flip 3D" effect 
on your demonstration system. Which edition of 7 should you advise the 
customer NOT to buy? 
Home Basic. 

6) In terms of system hardware, what is the main advantage of a 64-bit 
version of Windows? 
Support for more than 4 GB RAM. 

7) True or false? Windows XP does not support CPU extensions to improve 
virtualization performance such as VT-x or AMD-V. 
False - though XP does need to be patched to Service Pack 2. 

8) You want to upgrade a Windows XP system to Vista. The XP system has a 
1 GHz Pentium 4 CPU, 512 MB RAM, an onboard graphics adapter, and a 
20 GB hard disk. Does this PC meet the minimum system requirements? 
Just about for Home Basic - other editions would require a graphics 

adapter with 128 MB RAM and a larger hard disk (40 GB). 

9) You want to make full use of a 2-CPU Xeon-based workstation. Which 
editions of Windows 7 should you consider? 
Professional or Ultimate (or Enterprise if you also happen to have a 

Software Assurance license). 

10) Which versions of Windows can be upgraded directly to Windows XP 
Professional? 
Windows 98, Windows Me, Windows 2000 Professional, Windows NT4 

Workstation (SP5). 

 
 

 
 

Run lab 1 after 
completing the review 
questions with the 
students. 
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Module 1 / Unit 2 
Administration Tools 

Objectives 

On completion of this unit, you will be able to: 

■ Use administrative tools (Control Panel, Command Prompt, Computer 
Management). 

■ Navigate between drives and directories and identify the location of system 
files and folders. 

■ Use the shutdown command. 

■ Understand the structure of the Registry and make edits to it. 

Control Panel 

 
There are a number of tools used to configure Windows settings and hardware 
devices. Some of the tools are accessible to ordinary users; others need 
"administrative" privileges to run. 

The Control Panel is the best place to start configuring your system. Each 
icon in the Control Panel represents an applet used to configure some part of 
the system. Most applets are added by Windows but some software 
applications, such as anti-virus software, add their own applets. Configuration 
information stored in the Windows Registry is held on a per system or per 

user basis, and the icons within Control Panel reflect this, although some parts 
of some applets contain both system and user settings. 

 Wherever possible, modify system settings through Control Panel 

rather than edit the Registry.  

You can access Control Panel through the Start menu or through (My) 
Computer on the desktop. In addition, certain applets are accessible by 
viewing object properties straight from the desktop or from Explorer. 

In Windows 7, Control Panel applets are arranged by category by default 
though you can display "All items" via the breadcrumb or the "View by" menu. 
Note that options with the  icon on or next to them will require you to 
authorize use of the command through User Account Control (UAC). 

  
 

 
 

Delivery Tips 

It is important that 
students learn how to 
run each tool. 

Timings 

Theory & Review 
Questions - 30 
minutes 

Labs - 30 minutes 
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Windows 7 Control Panel showing 1) Task groups; 2) Configuration applets; 3) Navigation 

breadcrumb; 4) Search box 

Under Windows XP, Control Panel can be viewed in either Category View or 
Classic View. Category view presents a simplified wizard style interface, 
suitable for home users. Classic view shows each applet individually. 

 
Windows XP Control Panel - Category View 

System Properties  

 
The System settings include network identification and domain membership, 
hardware settings and configuration, user and hardware profiles, and 
performance and recovery options. 

 
 

 

http://gtsgo.to/f4psq
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My Computer 

My Computer provides access to your local drives (whether hard, floppy, 
optical, or flash-based [USB or memory card]), printers, and any network 
drives that have been mapped. 

 One of the cosmetic changes in Vista is that the "My" designation 

has been dropped; so "My Computer" is listed simply as 

"Computer", "My Documents" just appears as "Documents", and so 

on. In Windows 7, "My" Documents has been restored but not "My" 

Computer. 

To browse resources, open My Computer then the icon that represents the 
resource you want to view.  

By alt-clicking the My Computer icon itself and selecting the Properties option 
from the menu, you can access the System properties described below. 
Alternatively, you can open the System icon in Control Panel. 

General System Properties 

In Windows XP, the General tab of the System Properties dialog gives 
information about the system, such as the processor type and registered 
owner. 

Under Windows Vista and Windows 7, the General tab is replaced by a 
System Properties home page displaying additional summary information 
about the computer, including the Windows edition, product key, and activation 
status. 

 
Windows 7 system properties 

Click the Tasks or Change settings links to access the configuration dialogs. 
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Microsoft Management Consoles and 
Administrative Tools 

 
One of the options in Control Panel is the Administrative Tools shortcut9. 

 
Administrative Tools in Windows 7 

Administrative Tools contains a number of shortcuts, giving you the ability to 
define and configure various advanced system settings and processes. There 
are also several tools to assist with troubleshooting the system. 

Default Microsoft Management Consoles 
 
Administrative Tools is a collection of pre-defined Microsoft Management 

Consoles (MMC). Each console contains one or more snap-ins that are used 
to modify various settings. The principal consoles are: 

■ Component Services - enables you to register new server applications or 
reconfigure security permissions for existing services. 

■ Computer Management - allowing the administrator to configure local 
users and groups, disks, services, devices, and so on. 

■ Data Sources - control data connections set up on the local computer. 

■ Event Viewer - allows monitoring of Windows logs. System, security, and 
application events are recorded in these logs.  

                                                      
9 Administrative Tools can also be displayed on the Start Menu by adjusting its properties. 

 
 

Make sure students 
are familiar with the 
terminology: snap-in, 
MSC, etc. 
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Local computer management in Windows XP 

■ Local Security Policy - allows you to view and edit the current security 
policy (a computer that is a member of a domain will have the security 
settings defined in the domain security policy). 

■ Performance Monitor - viewing the performance of the local computer. 
Vista/7 has an improved Reliability and Performance Monitoring tool 
and also a Memory Diagnostic Tool. 

■ Services - start, stop, and pause services. 

Customizing MMCs  
 
As well as using the default consoles, you may find it useful to create your 
own. To access management console itself, click Start > Run, type mmc and 
click OK. The standard, empty console appears. You can now use the 
Console menu to add or remove any snap-ins. Consoles may be configured 
for each administrator and the details saved as a file with an MSC extension in 
their Start menu folder. 

 Most MMC snap-ins can be used to manage either the local 

computer or a remote computer (a computer elsewhere on the 

network). 
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Adding a Snap-in in Windows 7 

Command Prompt and Text Editors 

 
Most configuration of Windows can be done via convenient GUI interfaces, 
such as the management consoles and Control Panel. In some circumstances 
though, it is necessary to use a command prompt to configure or troubleshoot 
a system. As you learn the commands better, you may also find it quicker to 
use the command shell for actions such as file management. Learning 
commands is also valuable if you have to write scripts to automate Windows. 

Run Command 
 
Using the Start > Run dialog, you can open any file or program by typing the 
path to the file. In the case of registered programs and utilities, you simply 
need to type the program file name or utility name. 

 
Run dialog box 

 

http://gtsgo.to/g2amd
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In Windows 7, the Instant Search box at the bottom of the menu replaces the 
Run command10 and will execute programs and configuration options using 
simple names. 

 Display the Run dialog quickly by pressing Start+R. Activate 

Instant Search even more simply by pressing the Start key. 

You can also execute commands from the Run dialog. If a command is 
interactive, it will open a command prompt window (see below) for input. If a 
command is non-interactive, the command prompt window will open briefly and 
close again as the command executes. 

 The Run command is useful if you want to execute a program with 

switches that modify the operation of the software. For example, 

Microsoft Office programs can be executed using safe mode 

switches for troubleshooting. 

Opening the Command Prompt  

You can run any command from the Run dialog. However, to input a series of 
commands or to view output from commands, you need to use the command 
shell (CMD.EXE). To open the prompt, type cmd at the Run dialog or Instant 
Search box or use the shortcut in the Accessories program group on the Start 

menu. 

 
Command Prompt 

In Windows Vista/7, you may need to run the command prompt with elevated 

privileges in order to execute a command. To do this, alt-click the command 
prompt shortcut and select Run as administrator then confirm the UAC (User 
Account Control) prompt. Alternatively, type cmd in the Instant Search box then 
press Ctrl+Shift+Enter. 

                                                      
10 You can still access the Run command using Start+R, entering run into the search box, or by 

opening the shortcut in the Accessories program group. 
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To run a command, type it at the prompt (>) using the command name and 
any switches and arguments using the proper syntax. When you have typed 
the command, press Enter to execute it. The syntax of a command lists which 
arguments11 you must use (plus ones that are optional) and the effect of the 
different switches. Switches are usually preceded by the forward slash escape 
character.  

As you enter commands, the prompt fills up with text. If this is distracting, you 
can use the cls command to clear the screen. 

Some commands, such as nslookup or telnet, can operate in interactive 
mode. This means that using the command starts that program and from that 
point, the prompt will only accept input relevant to the program. To exit the 
program you use the exit or quit command (or press Ctrl+C). 

Other Command Prompts 

Running a command prompt within Windows makes the commands from the 
Windows command shell (CMD.EXE) available. 

The Windows XP troubleshooting utility Recovery Console is also used at a 
command prompt, but the environment is restricted compared to the full 
version of Windows. Conversely, the Windows Vista/7 Recovery Environment 

(RE) command prompt is basically the same as that of the full product. If you 
use a DOS or Windows 9x startup disk, the command environment is different 
again. Also, you will not be able to access NTFS drives. 

Getting Help 

The command prompt includes a rudimentary help system. If you type help at 
the command prompt then press Enter, a list of available commands is 
displayed. If you enter help CommandName, help on that command is 
displayed, listing the syntax and switches used for the command. You can also 
display help on a particular command by using the /? switch (for example, 
format /? displays help on the format command). 

 
Help on the format command 

                                                      
11 If an argument, such as a file path, includes a space it needs to be entered within quotes ("..."). 

 
 

Also note use of Tab + 
Arrow keys to cycle 
through previously 
entered commands. 

You may also want to 
note that Vista/7 
comes with a file / 
folder name 
completion feature 
when working at the 
command line. Press 
Tab and the interpreter 
will fill in the first folder 
/ file in the directory; 
alternatively type a few 
letters then press Tab 
and the interpreter will 
fill in the name. 
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Text Editor 

 
Many files used by the operating system and applications are in a binary file 
format that can only be interpreted by the application. A plain text file can be 
modified in any text editor, but if it is saved through an application other than a 
basic text editor, it could be converted to a binary format and so become 
unusable. 

In Windows XP, there is a command prompt plain text editor called EDIT.COM 
suitable for changing system files. Unlike a word processor, it does not put any 
special characters in a file that may render it unreadable to the system. 

The utility can either be used to create a new file (simply enter edit or edit 
FileName12) or to edit an existing file: edit C:\boot.ini 

 
Command prompt text file editor 

The menu will respond to mouse clicks or you can use Alt to navigate it 
using the keyboard. Basic keyboard shortcuts, such as Ctrl+V to paste, are 
also supported.  

When you have finished editing, remember to save the file. The program will 
prompt you if there are unsaved changes. 

In Windows Vista/7, the edit command is no longer supported. Use the GUI 
text editor notepad to modify files (for example, run notepad 
C:\boot.ini). 

                                                      
12 Obviously if you enter an existing file name, the file will be opened for editing. Using a file name 
does not automatically create the file. You need to save the file first. 
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Batch Files and Scripts 

A batch file is a plain text file saved with a .BAT or .CMD extension. The file 
should contain commands entered onto separate lines. When the batch file is run, 
each command executes in sequence. 

The command @echo off is usually added to the top of the file to suppress 
the display of commands. A batch file can also accept user input, by entering 
an argument as a variable of the form %1. 

A script can be used to create a mini-program, working with all the 
functionality of the chosen scripting language. Scripts can automate many 
functions of Windows. Most Windows scripts use VBScript (Visual Basic 
Script), which are given the extension .VBS. JavaScript is also used (.JS). 

Batch files and scripts are commonly used to set up the user environment or 
copy files for backup. They can be run manually, automatically at logon (as 
part of a login profile), or automatically at any time using the Task Scheduler. 

File Structure and Paths  

 
Under Windows, system objects are organized in a hierarchy. In Windows XP, 
the desktop is at the top of the hierarchy and contains shortcuts, files, My 

Computer, My Network Places, Recycle Bin, and the current user's My 

Documents object.  

 
Windows XP folder hierarchy 

My Computer contains local, removable, and network drives plus the Control 
Panel. 

This topic is not part of 
the objectives so you 
can skip it if you 
prefer. 

 
 

Students need to 
understand the 
Desktop hierarchy and 
how user profiles are 
stored under the 
different versions of 
Windows. 

You might also want to 
discuss roaming 
profiles, though they 
should not come up on 
the exam. 
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Standalone or workgroup installations of Windows XP also include a "Shared 
Documents" folder that is accessible to all users of the computer. 

Vista has the same sort of hierarchy but some different terminology and 
organizational principles. The desktop is still the container object but within 
that are a User folder (named after the user account), a Public folder, the 
Computer object, the Network object, Control Panel, and the Recycle Bin. 
The User object contains numerous subfolders, including Documents, Pictures, 
Videos, Downloads, Contacts, and so on. 

 
Windows Vista folder hierarchy 

In Windows 7 each profile folder still contains subfolders for different types of 
file (renamed back to the XP conventions of "My Documents", "My Music", "My 
Pictures", "My Video", and so on). However, user access to the profile folder is 
largely mediated through the Libraries feature. 

 See Unit 1.5 for notes on the use of Libraries. 

Drives in My Computer  

Within My Computer, drives are referred to by letters and optional labels. A 
"drive" can be a single physical disk or a partition on a disk. A drive can also 
point to a shared network folder "mapped" to a drive letter. By convention, the 
A: drive is the floppy disk and the C: drive is the active (bootable) partition on 
the primary hard disk.  
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Every drive (partition or volume) contains a directory called the root directory. 
The root directory is represented by the backslash ( \ ). For example, the root 
directory of the C: drive is C:\ Below the root directory is a hierarchical 
structure of directories called subdirectories. A sample directory structure is 
shown in the diagram: 

 
Typical Windows directory structure 

Files may be stored at each level, including the root level. The convention is to 
keep as few files as possible in the root directory. 

Windows XP System Files and Folders 

The root directory of a typical Windows XP installation normally contains the 
following files and subdirectories: 

■ Windows13 - the system root, containing drivers, logs, add-in applications, 
system and registry files (notably the System32 subdirectory14), fonts, and 
so on. 

■ Program Files - subdirectories for installed applications software15. 

■ Documents and Settings - storage for users' profile settings and data. 
Each user has a folder named after their user account. This subfolder 
contains NTUSER.DAT (Registry data), My Documents, Temporary 
Internet Files, Cookies, recent file shortcuts, desktop shortcuts, temporary 
files created by applications, and so on. 

 This folder also includes "All Users", which contains desktop and Start 
menu shortcuts for all users of the computer. Windows XP uses this 
profile's Documents folder to share files between different users (Shared 
Documents). It also contains a folder called "Default User", which is the 
template for new user profiles. 

■ Inetpub - if the web server Internet Information Services (IIS) is installed, 
this folder is created to store the default website and settings. 

                                                      
13 If the computer was upgraded from Windows 2000, this folder is called WINNT. 
14 System32 contains most of the applications and utilities used to manage and configure Windows. 
This is true even of 64-bit versions of Windows (32-bit Dynamic Link Libraries [DLL] running under 
64-bit Windows are stored in the SYSWOW64 folder). 
15 In 64-bit versions of Windows, a Program Files (x86) folder is created to store 32-bit 
applications. 

 
 

Students should learn 
the location of system 
files and directories. 
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■ ntldr - OS loader. 

■ ntdetect.com - detects hardware devices. 

■ boot.ini - multi-boot OS loader menu. 

■ pagefile.sys - Virtual Memory pagefile. 

■ hiberfil.sys - image of memory contents saved when the computer is put 
into hibernation. 

■ io.sys / msdos.sys / config.sys / command.com / autoexec.bat - 
Windows 9x boot and configuration files (these may be present if the PC is 
configured to dual boot or was upgraded). 

A listing of the root directory would show all the first level directories on the 
disk and a few system files, including those above16. 

Windows Vista and Windows 7 System Files and 
Folders 

Vista/7 comes with a few changes to the default system folders: 

■ Windows - the system root. 

■ Program Files - subdirectories for installed applications software. 

■ Users - replaces Documents and Settings. The internal layout of the 
profile folders is flatter, with subfolders for "Music", "Pictures", 
"Downloads", "Saved Games", and "Searches", in addition to "Documents". 
The profile folder also contains hidden subfolders used to store application 
settings and customizations, favorite links, shortcuts, temporary files, and 
so on. The "All Users" profile is called "Public"17.  

 In Windows 7, each profile folder still contains subfolders for different types 
of file (now renamed back to the XP conventions of "My Documents", "My 
Music", "My Pictures", "My Video", and so on). Access to the profile folders 
is mediated through Libraries. 

■ Boot - contains the Boot Configuration Database (BCD) and log files. 
This replaces BOOT.INI. 

 In Windows 7, if the default installation options have been used, the Boot 
folder is stored in the hidden System Reserved partition. 

■ C:\Windows\System32\winload.exe - OS loader; replaces NTLDR. 

■ C:\Windows\System32\winresume.exe - OS loader invoked when the 
computer has been put into hibernation. 

                                                      
16 At least, it will if the directory browser is configured to show hidden and system files. 
17 Various hidden "Junction Points" are created using the old folder terminology ("My Documents", 
and so on). These are used for compatibility with pre-Vista applications. If junction points are 
unhidden, they appear like shortcut icons. Clicking one results in an "Access Denied" message 
however. 
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■ pagefile.sys - Virtual Memory pagefile. 

■ hiberfil.sys - image of memory contents saved when the computer is put 
into hibernation. 

System Variables 

When entering directory paths as arguments, you may not know exactly which 
locations were chosen for installation. The shell recognizes a number of 
system variables and replaces the correct path when one of these is used. 
Some of the common variables include: 

■ %SystemDrive% - for example, "C:" 

■ %SystemRoot% - for example, "C:\Windows" 

■ %UserName% - for example, "george" 

■ %HomeDrive% - for example, "C:" 

■ %HomePath% - for example, "\Documents and Settings\george" 

You can view the full list of variables using the set command (without 
switches) at the command prompt. set also lets you create and modify new 
variables. You can also view variables through the Advanced page of the 
System Properties dialog by clicking the Environment Variables button. 

 
Environment Variables dialog 
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Shut Down  

 
When the user wants to finish using Windows, simply disconnecting the power 
(a hard reset) runs a risk of losing data or corrupting system files. There are 
various choices for closing or suspending a session: 

■ Shut down (/s) - close all open programs (the user should save changes in 
any open files first) and services before powering off the computer. 

■ Standby / Sleep - save the current session to memory and put the 
computer into a minimal power state. 

■ Hibernate (/h) - save the current session to disk before powering off the 
computer. 

■ Log off (/l) - close all open programs (the user should save changes in 
any open files first) and services started under the user account but leave 
the computer running. 

■ Switch user - log on to another user account, leaving programs and files 
under the current account open. 

■ Lock - secure the desktop with a password while leaving programs running. 

■ Restart (/r) - close all open programs (the user should save changes in 
any open files first) and services before rebooting without powering down 
(a soft reset). 

These options can be selected from the Start menu or by pressing 
Ctrl+Alt+Del.  

 
Options on the Windows 7 power button 

 See Unit 2.2 for notes on configuring these options via power 

settings and plans. 

The computer can also be shut down at a command prompt using the 
shutdown command plus the relevant switch (shown above). If a shutdown is 
in progress, shutdown /a aborts it (if used quickly enough). The /t nn 
switch can be used to specify delay in seconds before shutdown starts; the 
default is 30 seconds. 

 
 

 

http://gtsgo.to/y7r4l


Evaluation Use Only

  

 

Module 1 / Unit 2 

Page 36 

© 2013 gtslearning 

Windows Registry 

 
The Windows Registry provides a remotely accessible, unified database for 
storing operating system and device configuration information. 

When you boot a Windows machine, the Registry is populated with information 
about hardware detected in your system. This information is detected by 
NTDETECT.COM under Windows XP or WINLOAD.EXE under Windows 
Vista/7. During boot, Windows extracts information from the Registry, such as 
which device drivers to load and in what order.  

Device drivers also send and receive data from the Registry. The drivers 
receive load parameters and configuration data. A device driver may also 
report which system resources it is using, for example, memory address and 
hardware interrupts. Finally, whenever you run a setup program or configure 
the system via Control Panel or Administrative Tools it will add or change data 
in the Registry. 

The Registry does have a dedicated tool called regedit for direct editing, but 
it is not the tool you would use on an everyday basis to modify configuration 
data. Control Panel and Administrative Tools are better options for most tasks.  

Registry Structure 

The Registry is structured as a set of five subtrees (or keys) that contain 
computer and user databases. The computer database includes information 
about hardware and software installed on the computer. The user database 
includes the information in user profiles, such as desktop settings, individual 
preferences for certain software, and personal printer and network settings. 

Root Key Name Description 

HKEY_LOCAL_MACHINE Hardware information such as bus type, 
system memory, device drivers, and startup 
control data. HKLM also contains the 
Security Accounts Manager (SAM) 
password file (not viewable) and system-
wide software settings. 

HKEY_CLASSES_ROOT Object Linking And Embedding (OLE) and 
file association data. 

HKEY_CURRENT_USER Contains the profile for the user who is 
currently logged on, including environment 
variables, personal program groups, desktop 
settings, network connections, printers, and 
application preferences. 

HKEY_USERS Contains all actively loaded user profiles, 
including HKEY_CURRENT_ USER, which 
always refers to a child of HKEY_USERS, 
and the default profile.  

HKEY_CURRENT_CONFIG Contains system and software configuration 
information specific to this session. 

 

 
 

The objectives only 
specify using regedit 
so this section may go 
a bit beyond what is 
required but students 
should understand 
how to navigate the 
Registry and the types 
of data that can be 
added as values.  
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Each individual key can contain subkeys and data items called value entries. 
Keys are analogous to folders and the value entries are analogous to files. A 
value entry has three parts: the name of the value, the data type of the value, 
and the value itself. The following table lists the different data types: 

Data Type Description 

REG_BINARY Raw binary data. Most hardware component 
information is stored as binary data and displayed in 
hexadecimal format. 

REG_DWORD Data represented by a 4-byte number. Many 
parameters for device drivers and services are this 
type and can be displayed in binary, hex, or decimal 
format. 

REG_SZ A string or sequence of characters representing 
human-readable text. 

REG_MULTI_SZ A multiple string. Values that contain lists or multiple 
text values are usually this type. Entries are 
separated by NULL characters. 

REG_EXPAND_SZ An expandable data string, which is text that 
contains a variable to be replaced when called by an 
application. For example, for the following value, the 
string %SystemRoot% would be replaced by the 
actual location of the folder containing the Windows 
system files. 

 

Registry Database Files  

The Registry database is stored in binary files called hives. A hive comprises a 
single file (with no extension), a .LOG file (containing a transaction log), and a 
.SAV file (a copy of the key as it was at the end of setup). The system hive 
also has an .ALT backup file. Most of these files are stored in the 
%SystemRoot%\System32\Config folder, but hive files for user profiles are 
stored in the folder holding the user's profile. The following table shows the 
standard hives18. 

Hive Files 

HKEY_CURRENT_CONFIG system, system.alt, system.log, 
system.sav 

HKEY_CURRENT_USER ntuser.dat, ntuser.dat.log 
HKEY_LOCAL_MACHINE\SAM sam, sam.log, sam.sav 
HKEY_LOCAL_MACHINE\SECURITY security, security.log, security.sav 
HKEY_LOCAL_MACHINE\SOFTWARE software, software.log, 

software.sav 
HKEY_LOCAL_MACHINE\SYSTEM system, system.alt, system.log, 

system.sav 
HKEY_USERS\.DEFAULT default, default.log, default.sav 

 

                                                      
18 HKEY_CLASSES_ROOT is not stored in a hive but built from the \SOFTWARE\CLASSES keys 
in CURRENT_USER and LOCAL_MACHINE. 
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Editing the Registry  

 
Editing the registry 

The Registry Editor can be invoked by running regedit via the Start > Run 
menu or the command prompt. You can use it to view or edit the Registry and 
backup and restore portions of the Registry. Use the Find tool (Ctrl+F) to 
search for a key or value.  

If you want to copy portions of the Registry database and use them on other 
computers, use the Export Registry File option from the File menu. The file 
will be exported in a Registry compatible format, and can be merged into 
another computer's Registry by double-clicking the file (or calling it from a 
script). 

A registration file is a plain text file. If you merge changes from a .REG file 
back to the Registry, additions that you have made to the Registry will not be 
overwritten. Use the Registry Hive Files format to create a binary copy of that 
portion of the Registry. Restoring from the binary file will remove any additions 
you made as well as reversing changes. 

 
Selecting a file format for exporting a Registry key 
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Index 

Where a term or phrase is abbreviated, the abbreviation is the form listed in 
the index. Note that index references are made to the nearest main heading for 
the topic in which the term appears. 

[ 

[Command Name] / ? ... 28 
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AC Adapter ................ 269 
Access Control .... 42, 241, 
343 
Access Control List .... 343 
Access Denied ........... 307 
ACPI ........................... 113 
Action Center ..... 218, 237 
Activation ................... 162 
Active Directory ............ 40 
Active Partition ............. 51 
Adapter Card .............. 278 
Add Hardware Wizard 105 
Add/Remove Programs 85 
Adding Arrays............... 58 
Adding Drives ............... 56 
Administrative Share .. 341 
Administrative Tools .... 24, 
120 
Administrator Account . 41, 
42 
Advanced Security ..... 373 
Advanced Startup Options
 ................................... 198 
Adware ............... 226, 228 
Aero ....................... 7, 126 
Airplane Mode ............ 404 
Alerts .......................... 264 
Algorithm .................... 243 
Allocation Unit .............. 53 
Allow versus Deny ...... 347 
Alternate Configuration
 ................................... 326 
Android ....................... 399 
Answer Files............... 165 
Anti-virus Software .... 232, 
233 
APIPA ................ 326, 377 
App Source ................ 397 
Application 

Installation ....................... 85 

Application Compatibility
 ............................. 88, 223 
Application Virtualization
 ................................... 175 
Archive Attribute . 144, 349 
Artifacts ...................... 289 
ASR ............................ 208 
Assigning Drive Letters . 56 
Asymmetric Encryption
 ................................... 245 
attrib ........................... 349 
ATX ............................ 267 
Authentication ............. 246 
Automatic Updates ..... 137 
Autorestart .......... 203, 274 
AutoRun ..................... 251 

B 

Backdoor ............ 226, 236 
Backed Up Print Queue
 ................................... 305 
Background Process ... 90, 
93 
Backlight ..................... 295 
Backup ....................... 142 

Restoring data .............. 145 

System ................... 204, 207 

Badges ....................... 248 
Bare Metal Hypervisor 171 
Batch File ..................... 30 
Battery ........................ 293 
BCD ............................ 197 
Beep Code ................. 272 
Binary File Format ........ 29 
Biometric Device ........ 248 
BIOS ................... 141, 193 
BIOS Time / Settings 
Reset .......................... 273 
BlackBerry .................. 399 
Blank Pages ............... 309 
Blank Screen On Bootup
 ................................... 272 
Bleed .......................... 391 
Bluetooth .................... 401 
Boot Disk ............ 153, 209 
Boot Environment ....... 282 

Boot Files .................... 196 
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CompTIA A+ 802 Exam Objectives 

The material in this course will help you to learn and practice the CompTIA 
A+ Certification 220-802 exam covering the 2012 Edition exam objectives 
and content examples. 

 It is CompTIA's policy to update the exams regularly with new test 

items to deter fraud. The exam objectives may therefore describe 

the current "Edition" of the exam with a date different to that of the 

objectives. Please note that this training material remains valid for 

the stated exam code, regardless of the exam edition. 

The following tables list where the domain objectives of the 802 exam are 
covered in this course.  

A+ Certification 220-802 Domain Areas % of Exam 

1.0 Operating Systems 33%  
2.0 Security 22%  
3.0 Mobile Devices 9%  
4.0 Troubleshooting 36%  

Domain 1.0 Operating Systems 

Domain Objectives / Examples Unit 

1.1 Compare and contrast the features and requirements of 
various Microsoft Operating Systems. 
Windows XP Home, Windows XP Professional, Windows XP 
Media Center, Windows XP 64-bit Professional • Windows 
Vista Home Basic, Windows Vista Home Premium, Windows 
Vista Business, Windows Vista Ultimate, Windows Vista 
Enterprise • Windows 7 Starter, Windows 7 Home Premium, 
Windows 7 Professional, Windows 7 Ultimate, Windows 7 
Enterprise • Features (32-bit vs. 64-bit, Aero) • Upgrade paths 
(Differences between in-place upgrades, Compatibility tools, 
Windows Upgrade OS Advisor) 

1.1 Windows 
Operating 

System 

Features (Administrative Tools, File structure and paths, 
Category view vs. classic view) 

1.2 
Administration 

Tools 
Features (User Account Control) 1.3 Managing 

Users 
Features (Gadgets, Sidebar, Compatibility Mode, XP Mode) 2.1 Managing 

Applications 
Features (ReadyBoost) 2.3 Managing 

Performance 
Features (Shadow Copy, Windows Easy Transfer) 2.4 Maintenance 

and Backup 
Features (System Restore) 3.2 

Troubleshooting 
Boot Problems 

Features (Event Viewer) 3.3 
Troubleshooting 

Applications 
Features (Defender, Security Center) 3.4 Viruses and 

Malware 
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Domain Objectives / Examples Unit 

1.1 Compare and contrast the features and requirements of 
various Microsoft Operating Systems. 
Features (BitLocker) 

3.5 Workstation 
and Data 
Security 

Features (Windows Firewall) 5.3 Configuring 
Internet Access 

1.2 Given a scenario, install, and configure the operating 
system using the most appropriate method. 
Partitioning (Dynamic, Basic, Primary, Extended, Logical) • File 
system types/formatting (FAT, FAT32, NTFS, CDFS, Quick 
format vs. full format) 

1.4 Managing 
Storage 

Boot methods (USB, CD-ROM, DVD, PXE) • Type of 
installations (Creating image, Unattended installation, Upgrade, 
Clean install, Repair installation, Multiboot, Remote network 
installation, Image deployment) • Load alternate third party 
drivers when necessary • Workgroup vs. Domain setup • 
Time/date/region/language settings • Driver installation, 
software and windows updates • Factory recovery partition 

2.5 Installing 
Windows 

1.3 Given a scenario, use appropriate command line tools. 
OS (shutdown, [command name] /?) 

1.2 
Administration 

Tools 
OS (fdisk, format, diskpart, chkdsk) 1.4 Managing 

Storage 
OS (md, rd, cd, del, copy, xcopy, robocopy) 1.5 Managing 

Files 
OS (taskkill, tasklist) 2.1 Managing 

Applications 
OS (sfc) 3.2 

Troubleshooting 
Boot Problems 

OS (bootrec) • Recovery Console (fixboot, fixmbr) 4.2 
Troubleshooting 

Storage and 
Video 

Networking (ping, tracert, netstat, ipconfig, net, nslookup, 
nbtstat) 

5.4 
Troubleshooting 

Networks 
1.4 Given a scenario, use appropriate operating system 
features and tools. 
Administrative (Computer Management) • Run line utilities 
(regedit, cmd, mmc, notepad) 

1.2 
Administration 

Tools 

Administrative (Users and Groups) 1.3 Managing 
Users 

Disk Management (Drive status, Mounting, Extending partitions, 
Splitting partitions, Assigning drive letters, Adding drives, 
Adding arrays) 

1.4 Managing 
Storage 

Run line utilities (Explorer) 1.5 Managing 
Files 

Administrative (Services, System Configuration, Component 
Services, Data Sources) • msconfig (General, Boot, Services, 
Startup, Tools) • Task Manager (Applications, Processes, 
Performance, Networking, Users) • Run line utilities (msconfig, 
services.msc) 

2.1 Managing 
Applications 

Administrative (Device Manager) 2.2 Manging 
Devices 

Administrative (Performance Monitor) • Run line utilities 
(msinfo32, dxdiag) 

2.3 Managing 
Performance 

Administrative (Task Scheduler) • Other (User State Migration 
tool [USMT], File and Settings Transfer Wizard, Windows Easy 
Transfer) 

2.4 Maintenance 
and Backup 
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Domain Objectives / Examples Unit 

1.4 Given a scenario, use appropriate operating system 
features and tools. 
Administrative (Local Security Policy) 

3.5 Workstation 
and Data 
Security 

Administrative (Windows Memory Diagnostics) 4.1 
Troubleshooting 

System 
Components 

Administrative (Print Management)  4.4 
Troubleshooting 

Printers 
Run line utilities (mstsc) 5.2 Configuring 

Shared 
Resources 

Administrative (Windows Firewall, Advanced Security) 5.3 Configuring 
Internet Access 

1.5 Given a scenario, use Control Panel utilities. 
User Accounts 

1.3 Managing 
Users 

Folder Options (View hidden files, Hide extensions, Layout) 1.5 Managing 
Files 

Unique to Windows XP (Add/Remove Programs) • Unique to 
Windows 7 (RemoteApp and Desktop Connections) 

2.1 Managing 
Applications 

Display (Resolution) • Power Options (Hibernate, Power plans, 
Sleep/suspend, Standby) • Unique to Vista (Tablet PC settings, 
Pen and Input Devices) 

2.2 Manging 
Devices 

System (Performance [virtual memory]) 2.3 Managing 
Performance 

Unique to Windows XP (Automatic Updates) 2.4 Maintenance 
and Backup 

System (System Protection) 3.2 
Troubleshooting 

Boot Problems 
Unique to Vista (Problem Reports and Solutions) • Unique to 
Windows 7 (Action Center, Troubleshooting) 

3.3 
Troubleshooting 

Applications 
Security Center 3.4 Viruses and 

Malware 
Unique to Windows XP (Printers and Faxes) • Unique to Vista 
(Printers) 

4.4 
Troubleshooting 

Printers 
Unique to Windows XP (Network Connections) 5.1 Configuring 

Network 
Connections 

Folder Options (Sharing) • System (Remote settings) • Unique 
to Windows XP (Network Setup Wizard) • Unique to Vista 
(Offline files) • Unique to Windows 7 (Homegroup) 

5.2 Configuring 
Shared 

Resources 
Internet Options (Connections, Security, General, Privacy, 
Programs, Advanced) • Windows Firewall 

5.3 Configuring 
Internet Access 
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Domain Objectives / Examples Unit 

1.6 Setup and configure Windows networking on a 
client/desktop. 
Establish networking connections (Wireless, Wired) • 
Configuring an alternative IP address in Windows (IP 
addressing, Subnet mask, DNS, Gateway) • Network card 
properties (Half duplex/full duplex/auto, Speed, Wake-on-LAN, 
QoS) 

5.1 Configuring 
Network 

Connections 

Homegroup, File/print sharing • Workgroup vs. domain setup • 
Network shares/mapping drives • Remote Desktop 

5.2 Configuring 
Shared 

Resources 
Establish networking connections (VPN, Dial-ups, WWAN 
[Cellular]) • Proxy settings • Home vs. Work vs. Public network 
settings • Firewall settings (Exceptions, Configuration, 
Enabling/disabling Windows Firewall) 

5.3 Configuring 
Internet Access 

1.7 Perform preventive maintenance procedures using 
appropriate tools. 
Best practices (Scheduled backups, Scheduled check disks, 
Scheduled defragmentation, Windows updates, Patch 
management, Driver/firmware updates, Anti-virus updates) • 
Tools (Backup, Check Disk, Defrag) 

2.4 Maintenance 
and Backup 

Tools (System Restore, Recovery image) 3.2 
Troubleshooting 

Boot Problems 
1.8 Explain the differences among basic OS security 
settings. 
System files and folders 

1.2 
Administration 

Tools 
User and groups (Administrator, Power User, Guest, Standard 
User) 

1.3 Managing 
Users 

NTFS vs. Share permissions (Allow vs. deny, Moving vs. 
copying folders and files, File attributes) • Shared files and 
folders (Administrative shares vs. local shares, Permission 
propagation, Inheritance) • User authentication (Single Sign-
On) 

5.2 Configuring 
Shared 

Resources 

1.9 Explain the basics of client-side virtualization. 
Purpose of virtual machines • Resource requirements • 
Emulator requirements • Security requirements • Network 
requirements • Hypervisor 

2.6 Virtualization 
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Domain 2.0 Security 

Domain Objectives / Examples Unit 

2.1 Apply and use common prevention methods. 
Physical security (Lock doors, Tailgating, Securing physical 
documents/passwords/shredding, Biometrics, Badges, Key 
fobs, RFID badge, RSA token, Privacy filters, Retinal) • Digital 
security (Anti-virus, Firewalls, Anti-spyware, User 
authentication/strong passwords, Directory permissions) • User 
education • Principle of least privilege 

3.5 Workstation 
and Data 
Security 

2.2 Compare and contrast common security threats. 
Malware • Rootkits • Phishing • Spyware • Viruses (Worms, 
Trojans) 

3.4 Viruses and 
Malware 

Social engineering • Shoulder surfing 3.5 Workstation 
and Data 
Security 

2.3 Implement security best practices to secure a 
workstation. 
Setting strong passwords • Requiring passwords • Restricting 
user permissions • Changing default user names • Disabling 
guest account • Screensaver required password • Disable 
AutoRun 

3.5 Workstation 
and Data 
Security 

2.4 Given a scenario, use the appropriate data 
destruction/disposal method. 
Low level format vs. standard format • Hard drive sanitation and 
sanitation methods (Overwrite, Drive wipe) • Physical 
destruction (Shredder, Drill, Electromagnetic degaussing tool) 

3.5 Workstation 
and Data 
Security 

2.5 Given a scenario, secure a SOHO wireless network. 
Change default user names and passwords • Changing SSID • 
Setting encryption • Disabling SSID broadcast • Enable MAC 
filtering • Antenna and access point placement • Radio power 
levels • Assign static IP addresses 

5.1 Configuring 
Network 

Connections 

2.6 Given a scenario, secure a SOHO wired network. 
Change default user names and passwords • Enable MAC 
filtering • Assign static IP addresses • Disabling ports • Physical 
security 

5.1 Configuring 
Network 

Connections 
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Domain 3.0 Mobile Devices 

Domain Objectives / Examples Unit 

3.1 Explain the basic features of mobile operating systems. 
Android vs. iOS (Open source vs. closed source/vendor 
specific, App source [App Store and Market], Screen orientation 
[accelerometer/gyroscope], Screen calibration, GPS and 
geotracking) 

5.5 Mobile 
Devices 

3.2 Establish basic network connectivity and configure 
email. 
Wireless / cellular data network (enable/disable) • Bluetooth 
(Enable Bluetooth, Enable pairing, Find device for pairing, Enter 
appropriate pin code, Test connectivity) • Email configuration 
(Server address [POP3, IMAP, Port and SSL settings], 
Exchange, Gmail) 

5.5 Mobile 
Devices 

3.3 Compare and contrast methods for securing mobile 
devices. 
Passcode locks • Remote wipes • Locator applications • 
Remote backup applications • Failed login attempts restrictions 
• Anti-virus • Patching/OS updates 

5.5 Mobile 
Devices 

3.4 Compare and contrast hardware differences in regards 
to tablets and laptops. 
No field serviceable parts • Typically not upgradeable • Touch 
interface (Touch flow, Multitouch) • Solid state drives 

5.5 Mobile 
Devices 

3.5 Execute and configure mobile device synchronization. 
Types of data to synchronize (Contacts, Programs, Email, 
Pictures, Music, Videos) • Software requirements to install the 
application on the PC • Connection types to enable 
synchronization 

5.5 Mobile 
Devices 
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Domain 4.0 Troubleshooting 

Domain Objectives / Examples Unit 

4.1 Given a scenario, explain the troubleshooting theory. 
Identify the problem (Question the user and identify user 
changes to computer and perform backups before making 
changes) • Establish a theory of probable cause (question the 
obvious) • Test the theory to determine cause (Once theory is 
confirmed determine next steps to resolve problem, If theory is 
not confirmed re-establish new theory or escalate) • Establish a 
plan of action to resolve the problem and implement the 
solution • Verify full system functionality and if applicable 
implement preventive measures • Document findings, actions 
and outcomes 

3.1 
Troubleshooting 

Theory 

4.2 Given a scenario, troubleshoot common problems 
related to motherboards, RAM, CPU, and power with 
appropriate tools. 
Common symptoms (Unexpected shutdowns, System lockups, 
POST code beeps, Blank screen on boot up, BIOS time and 
settings resets, Attempts to boot to incorrect device, 
Continuous reboots, No power, Overheating, Loud noise, 
Intermittent device failure, Fans spin - no power to other 
devices, Indicator lights, Smoke, Burning smell, BSoD) • Tools 
(Multimeter, Power supply tester, Loopback plugs, POST card) 

4.1 
Troubleshooting 

System 
Components 

4.3 Given a scenario, troubleshoot hard drives and RAID 
arrays with appropriate tools. 
Tools (format, fdisk) 

1.4 Managing 
Storage 

Tools (chkdsk) 2.4 Maintenance 
and Backup 

Common symptoms (Read/write failure, Slow performance, 
Loud clicking noise, Failure to boot, Drive not recognized, OS 
not found, RAID not found, RAID stops working, BSoD) • Tools 
(Screwdriver, External enclosures, File recovery software) 

4.2 
Troubleshooting 

Storage and 
Video 

4.4 Given a scenario, troubleshoot common video and 
display issues. 
Common symptoms (VGA mode, No image on screen, 
Overheat shutdown, Dead pixels, Artifacts, Color patterns 
incorrect, Dim image, Flickering image, Distorted image, 
Discoloration [degaussing], BSoD) 

4.2 
Troubleshooting 

Storage and 
Video 

4.5 Given a scenario, troubleshoot wired and wireless 
networks with appropriate tools. 
Common symptoms (No connectivity, APIPA address, Limited 
connectivity, Local connectivity, Intermittent connectivity, IP 
conflict, Slow transfer speeds, Low RF signal) • Tools (Cable 
tester, Loopback plug, Punch down tools, Toner probes, Wire 
strippers, Crimper, ping, ipconfig, tracert, netstat, nbtstat, net, 
Wireless locator) 

5.4 
Troubleshooting 

Networks 

4.6 Given a scenario, troubleshoot operating system 
problems with appropriate tools. 
Common symptoms (RAID not detected during installation) 

2.5 Installing 
Windows 

Common symptoms (BSoD, Failure to boot, Improper 
shutdown, Spontaneous shutdown/restart, Boots to safe mode, 
Missing NTLDR, Missing Boot.ini, Missing operating system, 
Missing Graphical Interface, Graphical Interface fails to load, 
Invalid boot disk) • Tools (Recovery Console, sfc, Repair disks, 
Pre-installation environments, Safe Mode, Command prompt, 
Emergency Repair Disk, Automated System Recovery) 

3.2 
Troubleshooting 

Boot Problems 
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Domain Objectives / Examples Unit 

4.6 Given a scenario, troubleshoot operating system 
problems with appropriate tools. 
Common symptoms (Device fails to start, Missing DLL 
message, Service fails to start, Compatibility error, Slow system 
performance, File fails to open) • Tools (msconfig, defrag, 
regsrv32, regedit, Event Viewer) 

3.3 
Troubleshooting 

Applications 

Tools (fixboot, fixmbr) 4.2 
Troubleshooting 

Storage 
4.7 Given a scenario, troubleshoot common security 
issues with appropriate tools and best practices. 
Tools (Recovery Console, System Restore, Pre-installation 
environments) • Best practices for malware removal (Disable 
System Restore, Remediate infected systems [Scan and 
removal techniques (Safe Mode, Pre-installation Environment)], 
Enable System Restore and create restore point 

3.2 
Troubleshooting 

Boot Problems 

Common symptoms (Pop-ups, Browser redirection, Security 
alerts, Slow performance, Internet connectivity issues, PC locks 
up, Windows updates failures, Rogue anti-virus, Spam, 
Renamed system files, Files disappearing, File permission 
changes, Hijacked email, Access denied) • Tools (Anti-virus 
software, Anti-malware software, Anti-spyware software, Event 
Viewer) • Best practices for malware removal (Identify malware 
symptoms, Quarantine infected system, Disable System 
Restore, Remediate infected systems [Update anti-virus 
software, Scan and removal techniques (Safe Mode, Pre-
installation Environment)], Schedule scans and updates, 
Educate end user 

3.4 Viruses and 
Malware 

4.8 Given a scenario, troubleshoot, and repair common 
laptop issues while adhering to the appropriate 
procedures. 
Common symptoms (No display, Dim display, Flickering 
display, Sticking keys, Intermittent wireless, Battery not 
charging, Ghost cursor, No power, NumLock indicator lights, No 
wireless connectivity, No Bluetooth connectivity, Cannot display 
to external monitor) • Disassembling processes for proper re-
assembly (Document and label cable and screw locations, 
Organize parts, Refer to manufacturer documentation, Use 
appropriate hand tools) 

4.3 
Troubleshooting 

Laptops 

4.9 Given a scenario, troubleshoot printers with 
appropriate tools 
Common symptoms (Streaks, Faded prints, Ghost images, 
Toner not fused to the paper, Creased paper, Paper not 
feeding, Paper jam, No connectivity, Garbled characters on 
paper, Vertical lines on page, Backed up print queue, Low 
memory errors, Access denied, Printer will not print, Color 
prints in wrong print color, Unable to install printer, Error codes) 
• Tools (Maintenance kit, Toner vacuum, Compressed air, 
Printer spooler) 

4.4 
Troubleshooting 

Printers 
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Exam Tips 

Use the following notes to prepare for and book the CompTIA certification 
exam. Remember that you can use the practice exam available with this 
course at gtslearning's Freestyle site (you will also need an enrollment key 
from your training provider). 

Registering for the Test 

CompTIA Certification exams are delivered exclusively by Pearson VUE. You 
can locate a test center using the link on CompTIA's website: 

certification.comptia.org/Training/testingcenters.aspx 

■ Arrive at the test center at least 15-30 minutes before the test is scheduled. 

■ The test center administrator will demonstrate how to use the computer-
based test system. 

■ You must have two forms of ID - one with picture, both with signature, 
preferably with your private address (driving license, passport, and so on). 

■ Books, calculators, laptops, smartphones, or other reference materials are 
not allowed. 

■ Pens, pencils, and paper are not required! You must not attempt to write 
down questions or remove anything from the exam room. 

■ It is CompTIA's policy to make reasonable accommodations for individuals 
with disabilities. 

Taking the Test 
 
CompTIA have prepared a Candidate Experience video (gtsgo.to/hofvx). 
Watch this to help to familiarize yourself with the exam format and types of 
questions. 

■ There are up to 90 multiple-choice questions and performance-based 
items, which must be answered in 90 minutes. The passing score is 700 on 
a scale of 100-900.  

■ Read each question and its option answers carefully. Don't rush through 
the exam as you'll probably have more time at the end than you expect.  

■ At the other end of the scale, don't get "stuck" on a question and start to 
panic. You can mark questions for review and come back to them. 

■ As the exam tests your ability to recall facts and to apply them sensibly in a 
troubleshooting scenario, there will be questions where you cannot recall 
the correct answer from memory. Adopt the following strategy for dealing 
with these questions: 

Try to allocate some 
time to discuss the 
format of the exam.  

Make sure students 
understand that 
"unscored" items will 
appear that may test 
things that are not part 
of the exam objectives. 

For example, exam 
items that have been 
written for the next 
version of the exam 
objectives are often 
"seeded" into the 
current exams to 
gather psychometric 
data to check their 
validity. 

Discuss the format of 
the performance-
based items - students 
may be expected to 
label a diagram, 
configure some 
hardware, or complete 
some steps in 
Windows. You MUST 
NOT reveal the tasks 
or contents of specific 
items. 

Remind students that 
free practice exams 
are available on the 
Freestyle site. The 
enrollment key to give 
to the students is 
published on 
gtstrainer.com. 

http://certification.comptia.org/Training/testingcenters.aspx
http://gtsgo.to/hofvx
http://gtsgo.to/hofvx
http://gtsgo.to/hofvx
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 Narrow your choices down by eliminating obviously wrong answers.  

 Don't guess too soon! You must select not only a correct answer, but 
the best answer. It is therefore important that you read all of the options 
and not stop when you find an option that is correct. It may be 
impractical compared to another answer.  

 Utilize information and insights that you've acquired in working through 
the entire test to go back and answer earlier items that you weren't sure 
of.  

 Think your answer is wrong - should change it? Studies indicate that 
when students change their answers they usually change them to the 
wrong answer. If you were fairly certain you were correct the first time, 
leave the answer as it is.  

■ As well as multiple-choice questions, there will be a number of 
performance-based items. Performance-based items require you to 
perform a task or solve a problem in simulated IT environments. Use your 
experience of completing the labs in this course to help you complete the 
performance-based items successfully. Make sure you read the item 
scenario carefully and check your submission. 

■ Don't leave any questions unanswered! If you really don't know the answer, 
just guess. 

■ The exam may contain "unscored" questions, which may even be outside 
the exam objectives. These questions do not count towards your score. 

After the Test 

■ A score report will be generated and a copy printed for you by the test 
administrator. The score report will show whether you have passed or 
failed and domain objectives where you did not answer questions correctly. 
Make sure you retain the report! 

■ 5 days after passing the exam, go to www.comptia.org/careerid and create 
an account (or log on to an existing account) using the information in your 
score report. When you have passed both A+ exams, you can use this site 
to order your certificate and ID card. 

■ If 6 weeks have passed after ordering your certificate and you haven't 
received it, contact questions@comptia.org  

Retaking the Test 

If you do fail the certification test at the first attempt, then you can retake it at 
your convenience. However, should you fail the test at the second, third, or 
subsequent try, you will not be able to resit the exam for at least 30 days after 
your last attempt. Study your score report to see which areas of the exam you 
were weak on. 

Note that A+ is one of 
the CompTIA 
certifications now valid 
for 3 years (rather than 
for life as previously). 

The certifications can 
either be renewed by 
taking the next exam 
iteration or by joining 
the CompTIA 
Continuing Education 
Program and earning 
the relevant credits. 

For more information, 
direct students to 
gtsgo.to/5zmss. 

http://www.comptia.org/careerid
mailto:questions@comptia.org
http://gtsgo.to/5zmss
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Labs 

 
Lab 1 / Windows 7 

These practical labs will reinforce your understanding of the topics covered in 
the study notes and allow you to practice PC support tasks. In the course of 
these labs you will use up to three different types of system, depending on the 
facilities available in your training center. 

■ HOST PC - the computer you use for ordinary classwork. The HOST PC is 
installed with Oracle VirtualBox. VirtualBox allows for the installation of 
multiple operating systems on the HOST. 

■ VMs - in most labs you will practice installation, configuration, and 
troubleshooting tasks on Windows 7 and Windows XP VMs installed on the 
HOST (rather than the HOST itself). 

■ Workbench PCs - where the labs require hands-on with computer 
hardware, you will complete the exercises on older equipment (if available). 

In this lab you will start using a Windows 7 VM. VMs allow multiple operating 
systems to be installed to the same HOST PC. You will be able to log on to the 
Windows 7 VM as an administrator. 

Exercise 1: Logging On to the HOST 

1) Start your HOST PC. Make a note of the user name and password you will 
use to access the HOST: 

User name: ________________________________________ 

Password: _________________________________________ 

2) At the logon screen, select the appropriate user account and input the 
password then press Enter1. 

When you log on, the desktop is displayed. 

Exercise 2: Using VirtualBox 

In this lab, you will learn how to configure and start the Virtual Machines (VM).  

1) On the HOST PC, double-click the Oracle VM VirtualBox icon on the 
Desktop. 

The VirtualBox console is loaded. This shows the VMs available to you. 
Selecting a VM displays more information about it. 

                                                      
1 Logon options depend on the network and security options selected during installation. This 
computer is not joining a domain; if it were, you would need to press Ctrl+Alt+Del to display the 
logon box and there would be the choice of logging on to a domain account or to the local 
computer only. 

Delivery Tips 

If the students finish 
the exercises early get 
them to explore other 
options in Control 
Panel and 
Administrative Tools. 

Timings 

30 minutes 



Evaluation Use Only

  

 

Labs 

Page 12 

© 2013 gtslearning 

 
VirtualBox console 

You currently have one VM called WIN7. This is installed with Windows 7. 

2) With the WIN7 VM selected, click the Settings button.  

This dialog allows you to configure the VM's hardware. Some settings can 
only be changed when the VM is powered off; others you can change from 
the VM's window menu when it is running. 

3) Adjust any "System" or "Display" settings if suggested by your instructor. 

4) Click the Storage tab. 

 
Configuring VM storage options 
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This tab allows you to add hard drives to the VM and to use disc images 
ISOs) in the optical drive (or share the HOST's drive). 

5) Under "Storage Tree", select the "Empty" CD drive icon. 

6) In the "Attributes" panel on the right, click the CD icon and either browse 
for the ISO file for "Windows 7" or put the Windows 7 setup disc in the 
HOST DVD drive and choose Host Drive. 

7) Click OK. 

8) With the CLIENT VM still selected, click the Snapshots button. 

A snapshot is an image of the VM's disk at a particular point. You can use 
snapshots to discard the changes in a particular lab. 

 
Configuring snapshots 

9) Double-click the WIN7 VM to start it. A new window will open. 

Note that you are prompted to press a key to boot from the Windows 7 
setup disc. Do not press anything to allow the VM to boot normally. 

10) When the logon screen loads, the user name should be Bobby already. 
Enter the password Pa$$w0rd. 

 That's a zero between the "w" and the "r". 

11) On the VM window, click the Machine menu. You can configure some 
settings here (though you cannot change the installed hardware without 
shutting down the VM).  

12) From the Devices menu, select CD/DVD Devices > Remove disk from 

virtual drive. 

 If the mouse pointer gets "stuck" in a VM window, press Right-

Ctrl to release it. 

13) Look at the taskbar and observe the notification area / system tray on the 
right. You should see icons for configuring the network and speaker 
volume, as well as the date and time. 
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14) Note that a message may appear in the notification area - click the 

message icon  to view the Action Center alerts. 

Exercise 3: Start Menu, Taskbar, and Window Management 

In this exercise, you will explore the Start Menu and Taskbar and practice 
arranging windows on the Desktop. 

1) Alt-click an empty area on the taskbar and select Properties. Check the 
Auto-hide box, uncheck the Lock the Taskbar box, and click Apply.  

2) Click the Start Menu tab. Note the option to configure what the power 
button does.  

3) Click Customize. Scroll through the options then check the one to Display 

System Administrative Tools on All Programs Menu. Click OK to close 
both dialogs. 

4) You can use click-and-drag to resize or move the taskbar. Experiment with 
this (make sure you click-and-drag on an empty part of the bar not on an 
icon), leaving the taskbar in whichever part of the screen you prefer. Alt-
click it and select Lock the Taskbar. Note that you can no longer drag it 
around. 

5) Click Start and observe the menu options available.  

6) Click All Programs then run the mouse pointer up to the Administrative 

Tools program group then click on the Computer Management item to 
start the program. 

7) Browse a couple of the tools.  

You will be exploring the tools listed here in more detail later in the course. 

8) Point to the bottom of the screen to show the Taskbar and note the icon for 
the Computer Management window. Alt-click and select Pin this program 

to taskbar. 

9) Point to the Computer Management icon again to show its jump list then 
point to the jump list and click the Close button on it. 

10) Point to the Taskbar again and note that the Computer Management icon 
is present but not highlighted. 

11) Open the Start menu, alt-click the Computer item and note the menu 
commands. Properties opens the System Properties dialog. Select the 
Manage command. 

 There are often different ways of accessing system utilities. You 

should learn the different methods. 

You should be able to work comfortably with multiple windows. Use the 
control icons on the title bar and practice moving and resizing them. 
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12) Check the shortcut menu options from the taskbar for arranging windows 
and the Show Desktop / Aero Peek icon in the Notification Area. 

13) Drag windows to the left and right of the screen and note that they snap to 
fill half the screen. Drag a window to the top of the screen to maximize it. 

14) Close any open windows. 

15) Disable the Auto-hide property for the taskbar. 

Exercise 4: Accessing Files on the HOST 

In some labs in the rest of the course, you will need to use files from a folder 
on the HOST PC from the VM. You can do this using VirtualBox's Shared 

Folder feature. 

1) Alt-click the folder icon at the bottom of the VM window and select Shared 

Folders. 

 
Sharing a folder in VirtualBox 

2) Click the Add Share button . 

3) In the "Folder Path" box, type or select the C:\labfiles folder. Check 
the Auto-mount and Make Permanent boxes. Click OK. 

4) Click OK. 

5) On the VM, select Start > Computer. 

You should see the "labfiles" folder mapped as drive E:. 

Exercise 5: Closing the VM Session 

When you use the VM during a lab, you can either save changes you made 
during the lab to the VM's disk or discard them. You will be told which option to 
take at the end of each lab. In this lab, save the changes made to the VM. 

1) Select Start > Shut Down. 

2) In the VirtualBox Manager, alt-click the Current State snapshot and select 
Take Snapshot.  Enter the name Shared Host Folder and click OK. 

 
Creating a snapshot 
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Lab 2 / System Administration Tools 

In this lab you will explore the main tools used to configure and manage 
Windows. Complete this lab on the WIN7 VM. 

Exercise 1: Control Panel 

1) Start the VM and log on (Bobby / Pa$$w0rd). 

2) Press the Start key and start typing control panel. 

 The Start key is between Ctrl and Alt on the keyboard. 

 When the mouse is within the VM window, keyboard commands 

work on the VM not the host. The only exception is that you should 

press Right-Ctrl in place of Ctrl+Alt. 

After a few letters, you will see the icon for Control Panel selected at the 
top of the menu. 

3) Press Enter to open the Control Panel. 

 
Control Panel - click the breadcrumb (1) to move between folders and use the Search box (2) to 

locate items 

 Notice that some options have a Windows shield icon on top of or 

next to them. This icon represents a setting that will invoke UAC. 

4) Locate and open the Mouse applet, using either the breadcrumb or search 
function (as shown above). 

Timings 

30 minutes 
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The most important settings are configuring between right- and left-handed 
use and setting the double-click timing. You can also change the trail 
speed and select from any pointer themes installed. 

5) Take a look through the options and change any you wish to suit your own 
preferences. 

6) Click OK. 

7) Open the Keyboard applet. 

The main settings here are to configure the responsiveness of the keys 
and to set the correct input locale. 

8) Change the responsiveness settings if you wish. 

9) Click OK. 

10) Look at the settings under Clock, Language, and Region. You can use 
these to set the keyboard to the correct language type (US versus UK for 
instance), set the time zone, set the date and time correctly, or show a 
clock with a different time zone. 

 If you want to keep changes to the configuration of the mouse or 

keyboard, shut down the VM now and create a snapshot. Restart 

the VM and proceed with the remainder of the lab.  

Exercise 2: System Properties 

In this exercise, you will examine the system properties page. 

1) Select Start then alt-click Computer and select Properties. 

2) Open the System icon then browse through the information and options 
presented on the main page.  

Exercise 3: Creating a Management Console 

Management Consoles are configurable system utilities that can be adapted 
for different tasks. You saw one of the default management consoles in an 
earlier lab when you opened Computer Management. In this lab, you will use 
the MMC utility to create a custom console to manage hardware and services 
on the local machine. 

1) Press the Start key and enter mmc. Click Yes at the UAC prompt. The 
Console Root will display. 

2) Select Add/Remove Snap-in from the File menu.  

3) Select Device Manager, click Add, choose Local Computer, and then 
Finish. 

4) Repeat to add the Services snap-in for the local computer. 
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5) Click OK. 

6) Click to view each of the new entries. 

7) Select Save from the File menu. 

8) Enter the file name Local Management and click Save. 

9) Select Exit from the File menu.  

The console you created is accessed via your user account's 
Administrative Tools folder, accessible from the Start menu program group. 

10) Re-open the Console by clicking Start > All Programs > Administrative 

Tools > Local Management. Click Yes at the UAC prompt.  

11) Click Device Manager. 

12) Are there are non-functioning devices? 

Exercise 4: CPU-Z 

CPU-Z is a freeware tool developed by CPUID (www.cpuid.com). It reports 
detailed information about the processor, motherboard, and memory installed 
on the PC. 

1) Press Start+R to open the Run dialog (make sure you are still working 
within the VM), then enter E:\cpuz_1.61_setup-en.exe to launch the 
installer. 

2) Click Run at the Security Warning. 

The desktop is dimmed and a User Account Control (UAC) prompt is 
displayed. Notice that as you are already logged on as an administrator, 
you only have to confirm the prompt, rather than supply a password. 

3) Click Yes at the UAC prompt. 

4) Run through setup using the default options but do not install the Ask 
toolbar. 

5) Use the desktop icon to start CPU-Z, clicking Yes again when prompted. 

6) Note the extra information compared to System Properties. 

7) Click OK to close CPU-Z. 

Exercise 5: Using the Command Prompt 

In this exercise you will explore some of the basic features of the command 
line environment. 

1) Press the Start key, type cmd, then press Enter. 

2) Type help and press Enter to show a list of commands. 

Optionally, get the 
students to run CPU-Z 
on the HOST and 
compare the results. 

 

http://www.cpuid.com/
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3) Alt-click the title bar and select Edit > Select All. Press Enter. This copies 
the contents of the command window. 

4) Type notepad and press Enter. 

5) Press Ctrl+V to paste the command output. 

6) Close the file, saving it as commands. 

7) Back in the command prompt, type cmd /? and press Enter. 

The syntax of the command interpreter is shown. 

8) Read a couple of pages then press Ctrl+C to cancel and return to the 
prompt. 

9) Type exit then press Enter. 

Exercise 6: Exploring the Registry 

The Registry is a database of computer and user configuration settings. 
Usually changes are made by program installers and uninstallers and the 
Windows administrative tools but in some circumstances you may need to 
make edits directly. 

1) Press the Start key, type regedit, then press Enter. 

2) Click Yes at the UAC prompt. 

You can now see the Registry keys in the left-hand pane.  

3) Click the arrow next to HKEY_CURRENT_USER to see its subkeys. 

4) Select the Control Panel subkey then expand it to see its subkeys. 

5) If you cannot see the path you followed to get to this subkey at the bottom 
of the Registry Editor window, select the Status Bar from the View menu. 

6) Open the HKEY_LOCAL_MACHINE key and expand Software > 

Microsoft > Windows > CurrentVersion. 

7) Select Setup and observe the values. 

8) Select Run and observe the values. 

9) Open the HKEY_CURRENT_USER key and expand Software > 

Microsoft > Windows > CurrentVersion. 

10) Note that there is no Setup key. Select Run and observe the differences. 

11) Leaving the Registry Editor open, click Start > Run, type msconfig, and 
click OK. 

12) Click the Startup tab. Compare the values to the Registry Keys. 
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13) Uncheck one of the items and click Apply. Select the Registry Editor and 
press F5.  

14) In the System Configuration utility, check the box again to re-enable the 
item and click Apply. Refresh the Registry Editor. 

15) Close the System Configuration utility and click Exit Without Restart 
when prompted. 

16) Expand the HKEY_LOCAL_MACHINE key again. 

17) Select the System key under HKLM. Notice that there are two control set 
subkeys and a current control set. 

18) Expand HKEY_USERS. Notice that each user is listed by a unique 
identifier (SID) rather than a user name. 

19) Expand one of the users to view the subkeys. Now expand the 
HKEY_CURRENT_USER key - are the subkeys the same? 

___________________________________________________________ 

20) Select HKLM. From the Edit menu, select Find. Enter the search string 
microsoft.com , check the Data box only, and click Find Next. 

21) When you find a value, press F3 to search for the next. Repeat for a while 
to note which keys the data turns up in. 

Exercise 7: Exporting and Modifying Desktop Settings 

In this exercise, you will modify some Registry settings but first you will export 
the key to make a backup. 

1) Expand HKEY_CURRENT_USER and select the Desktop subkey of the 
Control Panel. 

2) What is stored in a key (or subkey)? 

___________________________________________________________ 

3) What are the two components of a value? 

___________________________________________________________ 

___________________________________________________________ 
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4) Write down the data stored in each value below (or N/A if a value is not 
present). 

 ScreenSaveActive 

___________________________________________________________ 

 ScreenSaveTimeOut 

___________________________________________________________ 

 Wallpaper 

___________________________________________________________ 

5) From the Registry Editor menu, select File > Export. 

6) In the "File Name" box, type wallpaper-reg. 

7) In the Export Range options, make sure that Selected Branch is 
selected, and click Save.  

8) From the Registry Editor menu, select File > Export. 

9) In the "File Name" box, type wallpaper-bin. 

10) From the "Save as type" box, select Registry Hive Files. 

11) In the Export Range options, make sure that Selected Branch is 
selected, and click Save.  

12) Alt-click Wallpaper and select Modify. In the box, type 
C:\users\public\pictures\sample pictures\penguins.jpg. 

13) Change TileWallpaper to 1. 

14) Close the Registry Editor. Is there any change? 

___________________________________________________________ 

15) Log off and on again. Has the change been applied now? 

16) Alt-click the Desktop and select Personalize. Click Screen Saver. 

17) Select the "Photos" screen saver and click OK. 
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18) Open the Registry Editor again and note the changes to the values you 
recorded above. 

19)  Select the following key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\ 

CurrentVersion\Run 

20) From the menu, select Edit > New > String Value. 

21) Replace New Value #1 with Notepad and press Enter. 

22) Double-click Notepad to open the Edit String dialog box. 

23) In the Value Data dialog box, type C:\windows\notepad.exe 

24) Click OK. 

25) Close the Registry Editor. 

26) Log off and log on. What happens? 

___________________________________________________________ 

27) Use msconfig to disable Notepad, choosing to Exit without Restart. 

Exercise 8: Importing a Key Into the Registry 

In this exercise, you will restore Registry settings from the backup files you 
made. 

1) Open the Registry Editor then from the menu, select File > Import. 

2) Select the wallpaper-reg file that should now appear in the file list and 
click Open. A message should appear saying that information in the reg file 
has been successfully entered into the Registry. 

3) Click OK. 

4) Log off and on again. The wallpaper should now have changed. Notice that 
the screen saver is still active however. 

5) Open the Registry Editor then from the menu, select File > Import. 

6) Change the file type to Registry Hive Files, select the wallpaper-bin file 
that should now appear in the file list, and click Open. 

7) Read the warning and click Yes. 

8) Click OK. 

9) Log off and on again. The screen saver should be disabled again. 
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Exercise 9: Closing the VM Session 

We will discard the changes made to the VM during this lab. 

1) Click the Close icon on the VM window. 

2) In the Close Virtual Machine dialog, select Power off the machine and 
check the Restore current snapshot box.  

3) Click OK. 

 
Discarding disk changes at the end of the lab 

The VM window will close. 
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Glossary 

⅛ Connector 

Standard 3.5mm audio socket (the type of jack found on headphones and basic 
speakers). 
10/100/1000BASE-T 

Specifications for Ethernet running over twisted pair cable at 10/100/1000 Mbps. 
32-bit 

Most programs and operating systems run in 32-bit mode. Aside from allowing 
the computer to access more memory (4 GB), programs are protected from one 
another; each runs in its own address space. 
64-bit 

The PC is starting to move to a 64-bit platform. 64-bit offers some speed 
improvements, especially for tasks such as 3D processing, but its main 
advantage is the increase in address space and better support for virtualization 
(running multiple OS on the same hardware).The main 64-bit platform is called 
AMD64 or EM64T (by Intel). This platform is supported by 64-bit versions of 
Windows XP / Vista / 7 as well as various Linux distributions. 
8.3 Filenames 
The DOS file naming standard - an eight-character ASCII name followed by a 
three-character file extension (which identifies the file type). Windows supports 
long file names but can also generate a short file name, based on DOS 8.3 
naming rules. This provides backwards compatibility for older applications. 
802.11 

See: Wi-Fi. 

802.1X 

802.1X (or EAP [Extensible Authentication Protocol]) is an authentication 
standard, developed to allow remote, wireless, and wired authentication to be 
centrally managed. A client device such as an access point passes 
authentication information to a RADIUS server on the wired network for 
validation. The authentication information could be a user name and password 
or could employ smart cards or tokens. 
802.2 

See: Ethernet. 

8mm Tape Backup 

8mm (¼") data tape storage systems appear similar to the tape cartridges used 
by many video cameras, although the media is higher quality. 
A/V (Audio/Video) 

Any receiver that can process audio and video signals. A/V signals can be 
analog or digital and there are numerous cable, connector, and signaling 
formats. 
AAA 

Authentication, Authorization, and Accounting - the principal types of security 
control. A resource should be protected by all three types of control. 
AC (Alternating Current) 

When electricity is produced by a generator at the power station, the rotational 
movement of the magnetic coils causes the current produced to oscillate like a 
sine wave (it is said to alternate). Computers require direct current (at a constant 
voltage). A transformer is used to convert AC from the power outlet into the 3.3, 
5, and 12V DC supply required by the computer. 
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